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ABSTRACT 

 This thesis presents designs and implementations of 2-D Particle Image Velocimetry 

(PIV), stereo-PIV, and selective seeding that enable application of PIV in large-scale, production-

type wind tunnels. The PIV systems use conventional tools and methods to capture flow 

characteristics in the 7 foot x 10 foot test section of the Oran W. Nicks Low Speed Wind Tunnel 

at Texas A&M University (LSWT). The systems are designed to measure velocity fields non-

invasively to prevent affecting flow quality. Validation tests demonstrate that in-plane velocity 

measurements obtained using the 2-D PIV system have measurement uncertainty below 0.5% 

which meets industry standards. Validation tests of stereoscopic PIV produced a similar result 

with a measurement uncertainty below 0.5% for in-plane velocities and below 5% for the out of 

plane velocity. Both values also meet their corresponding standards. A selective seeding system 

is implemented as a proof of concept for a method to overcome particle seeding challenges 

associated with very large-scale facilities. Velocity deficit measurements show the system does 

not significantly impact flow quality in the test section. Stereo PIV measurements captured 

behind a model demonstrate that the seeding column produced provides PIV data of equivalent 

quality to traditional, flooded-tunnel approaches.  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1. INTRODUCTION 

1.1 Motivation for Research 

This research is intended to solve challenges associated with implementation of Particle Image 

Velocimetry (PIV) in large-scale, production-type wind tunnel facilities. Researchers and test 

engineers at the National Full Scale Aerodynamic Complex (NFAC) and the Arnold Engineering 

Development Complex (AEDC) seek to implement PIV measurements in a routine way in their 

subsonic facilities but PIV in those facilities is hindered by a variety of challenges not present in 

smaller-scale research facilities. Both AEDC and NFAC facilities are operated by National 

Aerospace Solutions (NAS) under contract to the U.S. Air Force. To address these challenges, 

the Oran W. Nicks Low-Speed Wind Tunnel (LSWT) at Texas A&M University is being used to 

develop and test solutions to large-scale PIV challenges especially those relevant to production 

wind tunnels. In particular for this thesis, development of an alternative seeding method for large 

scale facilities was selected by NAS as a key objective.  

 The LSWT was selected as a test facility for large-scale PIV implementation tests 

because it is sufficiently large to face some of the same issues as larger-scale production facilities 

operated by NAS. However, the LSWT can be operated at sufficiently lower costs to enable 

inexpensive proof-of-concept testing. The LSWT is a large-scale wind tunnel facility (by 

university standards) that regularly conducts aerodynamic tests for research and commercial 

applications. While these tests vary greatly in length and complexity, each seeks to understand 

the aerodynamic effects experienced by wind tunnel models. LSWT instrumentation includes 

both a high-capacity external balance and multiple internal balances that measure loads 
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experienced by wind tunnel models. In many wind-tunnel tests, a balance provides the 

engineering result of an aerodynamic design: the aerodynamic forces and moments produced by 

a given configuration. However, the loads above are only part of what can be of value in a wind 

tunnel test. It can also be of value to measure the velocity field about a model. Particle Image 

Velocimetry (PIV) provides that capability. 

1.2 Facility Overview 

 Texas A&M’s Low Speed Wind Tunnel (LSWT) began construction in the 1940s and 

evolved into a closed-loop tunnel in the 1950s. The tunnel has continued to upgrade its systems 

and develop its capabilities. An automatic external balance was installed in the 1970s that 

eventually transitioned to a fully digital system. Forays into a 2-D PIV system were made during 

the late 2000s and early 2010s but only for a single project. Currently, flow field measurements 

at the LSWT can be taken using a multi-hole probe on a traverse mechanisms or on a wake rake. 

These techniques capture flow characteristics at discrete points or arrays of discrete points. Each 

of these methods capture data in the form of dynamic pressure which can be used to calculate 

local velocity. However, these systems are limited. First, both systems can only capture data at 

discrete points rather than entire fields. Second, the placement of the instruments could alter the 

flow about the model and change what the systems are attempting to measure. Finally, the probe 

and wake rake cannot capture data close to or in front of models due to how the instruments are 

mounted. As a result, it can be difficult to measure flow fields over individual features on a 

model which is usually the goal of flow field measurements. 
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 In contrast to the conventional pressure-based systems in use at the LSWT, a PIV system 

would significantly improve the capacity for flow-field measurements. Unlike the probe and 

wake rake, a PIV system is able to simultaneously capture data in a defined field of view. 

Additionally, using a PIV system removes the need for physical hardware inside the tunnel and 

does not risk aerodynamic interference caused by the mounting arrangements of other methods 

of flow field measurement. Finally, PIV allows for data capture at any point in the test volume. 

The cameras in a PIV system can be moved and manipulated as necessary to capture flow over 

virtually any feature of a model which allows for velocity measurements over critical 

components and regions of interest. This can be significant for both research and commercial 

applications and represents a significant improvement in the capabilities of the LSWT. 

1.3 Review of PIV 

 PIV has been widely used since the 1980s. The method allows researchers to non-

intrusively measure instantaneous velocity fields at many points (103 to 105) across a field of 

view (Adrian 2005). The method consists of capturing high-resolution images of illuminated 

seed particles that move with a flow then using computer software to determine the movement of 

each particle between subsequent images.  PIV can be advantageous compared to traditional, 

intrusive measurement techniques because it captures the instantaneous velocities in an entire 

region of interest without disturbing the flow itself. This region can either be a plane or a volume 

within the flow, depending on the type of PIV used. Two-dimensional (2-D) PIV is the simplest 

application of the method and is able to capture 2-D velocity components in the illuminated 
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plane (Adrian 2005, Scarano 2013). Stereoscopic and tomographic PIV are more complicated. 

These are able to produce three-dimensional velocity components. Stereoscopic PIV (SPIV) uses 

multiple cameras angled at an illuminated plane to measure both the in-plane and out-of-plane 

velocities. Tomographic PIV uses multiple cameras that image an illuminated volume to produce 

3-D velocity data in that volume flow data (Scarano 2013). 

 PIV systems usually use the combination of a laser to illuminate the particles in a flow 

and cameras with over 1 million CCD pixels and the ability to capture image pairs within 1 µs. 

Depending on the orientation of the system, a set of mirrors and lenses convert the pulsing laser 

beam into a thin light sheet in the test section where it illuminates seed particles. Seed particle 

selection is important; each particle must be small enough to follow the flow without substantial 

deviation while also reflecting sufficient light to be visible in images (Zhang et al. 2003). A 

synchronizing system is used to ensure the cameras collect data when the laser pulses.  

 After data is collected, image pairs are individually processed using image-analysis 

software. For this thesis, all data is processed using DaVis 8.4.0. For the analysis, each 

monochrome image pair is overlaid with a mesh of square elements. The program iterates 

through each square element, searching the second image of the pair for the nearby region that 

has the highest correlation to the first image. This results in a pixel shift vector that, when 

divided by the time between the images, produces a velocity field with one vector for each 

individual square element. A relatively coarse initial grid is analyzed first and a higher resolution 

grid is analyzed second using the coarse-grid result as an initial estimate to accelerate the 

subsequent fine-resolution analysis. 
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DaVis 8.4.0 software is used for data processing in this thesis. It’s approach is similar to any PIV 

processing software and is important to document because it informs later discussion of PIV 

measurement uncertainty. The overall approach is similar for 2-D and Stereoscopic PIV data but 

user inputs have small variations that are discussed below. In both cases, images are taken of a 

calibration plate in the region of interest using each camera (one for 2-D and two for stereo) and 

processed using the DaVis calibration function. An image of the calibration plate used for this 

thesis can be seen in Fig 1. It is 5 inches wide by 3 inches tall and includes an array of 40 × 31 

calibration dots on a 0.12-inch spacing.  

Figure 1: Calibration Plate 

The DaVIS software scans the calibration image and calculates the pixel scale.  For stereoscopic 

PIV, the software additionally uses the distortion of the plate in the calibration images to 

determine the each camera’s offset angle from the line normal to the calibration plate.  

 Data analysis for both methods of PIV begins with the import of pairs of  “A” and “B” 

images captured during testing. These images are greyscale light-intensity maps captured from 
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the illuminated particle field. The image pairs captured by each camera are processed using a 

cross correlation function that breaks image A into a grid of square interrogation regions. Starting 

with the interrogation region in the top right corner of image A, the software scans image B for a 

region of equal size that has the highest correlation value. This produces a vector on the vector 

field moving from the center of the interrogation region in image A to the center of the best-

correlated region of the same size in image B. This process is repeated until every interrogation 

region in image A has been assigned a corresponding correlated region in image B and this 

results in a full vector field over the region of interest. This process can then be repeated with a 

sequence of decreasing interrogation sizes. All PIV calculations for this thesis consist of an initial 

vector calculation with mesh elements 64 pixels × 64 pixels, followed by three subsequent passes 

with mesh elements of 32 pixels × 32 pixels. A smaller final interrogation size would give a 

denser vector field but results in poor correlation quality.  

 Stereoscopic PIV completes an additional processing step to generate in-plane and out-of-

plane velocities. Once an instantaneous vector field is obtained for both cameras, the software 

uses the calibrated offset angles and the individual vector fields to produce the full 3-component 

vector field. This is accomplished using the vector projection of the results of both cameras onto 

the plane of the laser sheet. Because particles near the edges of the image are somewhat out of 

focus because the cameras’ optical axes are not exactly normal to the image plane, data quality 

degrades near the edges of the image. This phenomenon is discussed at length in Section 3.2. 

 Especially when the camera offset angle is large, schiempflug adaptors are used to 

provide consistent image focus across the inclined field of view. Using these adaptors, each 

camera is focused on the center of the calibration card and the variation in image focus from the 
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center towards the edges of the image is reduced relative to not using the adaptors. This reduces 

the measurement uncertainty at the image edges. Because the focus of this thesis was not 

optimizing stereoscopic measurement quality, schiempflug adaptors were not purchased for this 

work. They will be recommended for future use. 

A typical experimental setup and data processing flowchart for a PIV system can be seen in 

Fig. 2 from Westerwheel et al. (2013). 

Figure 2: PIV Setup & Data Processing 
(Reprinted from Westerweel et al. 2013) 
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1.4 Synopsis of Large-Scale PIV Challenges 

 While PIV is a well-established method of measuring velocity in small-scale wind 

tunnels, using PIV in large-scale wind tunnel tests produces a wide array of challenges (Towers 

et al. 1991, Westerwheel et al. 2013).  Many of the complications stem from the necessity of 

high-resolution imaging in the experimental location of interest. In small-scale tests, cameras and 

laser sources may be arranged fairly close to the region of interest and can capture individual 

particles with relative ease. However, large-scale tunnels require the cameras and laser to be 

located much further from the region of interest. While these elements can be moved, seeding 

particles cannot be larger than in small-scale tunnels as they would no longer properly follow the 

flow. As a result, a complex optical setup is needed to properly illuminate the particles in the 

flow and capture sufficiently detailed images for analysis. Depending on the setup around the test 

section, the laser may require additional mirrors and lenses to properly align the beam with the 

test section. This can be problematic, as the additional optics decrease the power of the beam 

entering the test section of the tunnel. This decrease in power can lead to less illumination of the 

particles, resulting in increased measurement error or a failure to capture sufficient data for 

processing. 

 Additionally, the region of interest in large-scale tests is much larger than in traditional 

PIV applications. Currently, cameras with sufficiently high resolution to capture the entire field 

of interest without increasing individual pixel size can be difficult and expensive to obtain. And, 

at the scale envisioned for use in NFAC facilities, may not even exist. As a result, large-scale PIV 

systems often require a set of multiple cameras operating in parallel to photograph the entire 
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region of interest. Each camera must be carefully aligned to capture a unique section of the 

experimental region. During data reduction, images from the various cameras can be stitched 

together to produce a single depiction of the flow in the region of interest. While this is a 

theoretically simple process, dedicated testing is required to prove the efficacy of image stitching 

in large-scale PIV setups.  

 Particle seeding also becomes particularly challenging in large-scale applications. In 

small-scale tests, the amount of particulate utilized for any given test is fairly small and the entire 

tunnel can be filled to a selected particle density. This would not be cost effective for large-scale 

tests. Furthermore, flooding a large facility with seed particles may have major health and safety 

concerns. Regular particle choices such as silicon carbide or titanium dioxide are impractical due 

to their cost and the increased number of particles required to maintain sufficiently dense particle 

seeding. Researchers also caution against such particles due to the adverse health effects of these 

particles in large doses (Raffel et al. 2018). 

 A different seeding challenge is that tracking errors can occur when particles fail to 

follow the flow without slip. This is problematic in large scale facilities where larger particles are 

often used to compensate for the larger pixel scales associated with larger fields of view. While 

this keeps particles visible in PIV images, it also increases the likelihood that particles will slip 

in regions with strong fluid accleration. Additionally, the likelihood of inhomogeneous particle 

seeding grows with increased wind tunnel size. Inhomogeneous particle seeding can force data 

analysis programs to extrapolate results for sparsely seeded sections of an image which decreases 

accuracy.  
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 Large scale facilities also introduce unique challenges for optical alignment because of 

mechanical vibrations and flexures in the test section. At small scale, vibrations and flexure of 

the test section are small enough that a PIV system is not affected. However, large scale tests can 

often experience vibrations and flexure that can significantly affects the alignment of cameras 

and the laser optics during tests. These distortions often degrade the alignment of the PIV system 

such that the data produced must be corrected mathematically in post-processing. In particular, 

this affects more complicated PIV systems such as tomographic and holographic PIV. 2-D PIV 

systems are easier to set up but can be more tedious in operation because more system alignment 

runs are required to capture the needed data. For example, if researchers are trying to capture 

both the flow over a wing and the wingtip vortices, the PIV system will need to be moved and 

recalibrated for multiple measurement planes. This operation is less of an issue in small-scale 

tests, where equipment can be easily moved around the test section. However, in large scale tests 

this operation can include designing and implementing different optical setups and mounting 

considerations, making the change both time consuming and difficult to accomplish. 

1.5 Objective  

The objective of this thesis is to develop procedures and support infrastructure that enable 

accurate and efficient use of PIV at the Oran W. Nicks Low Speed Wind Tunnel. This includes 

the validation of 2-D and stereoscopic PIV that can be used during future research and customer 

projects to enhance the quality of data produced. These systems will include operational 

procedures and checklists that are found in Appendices A and B. These procedures and support 
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infrastructure are expected to be representative of the work needed to achieve the same ends in 

larger-scale production facilities such as NFAC and AEDC subsonic wind tunnels. In addition, 

this thesis seeks to demonstrate a method of selective seeding for large scale wind tunnels that 

meets the data quality of traditional seeding methods. This proof of concept will be a gateway to 

future work with other large-scale facilities seeking to implement PIV. The end product of this 

thesis includes a detailed procedural guide for both 2-D and stereoscopic PIV setup, optical 

alignment, data collection, data analysis and reporting, as well as a successful proof of concept 

for a selective seeding system. 
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2. REVIEW OF LITERATURE 

2.1 History of PIV  

 The earliest iterations of PIV began in the late 1970’s with three independent research 

groups. Adrian (2005) writes that each of these teams sought to demonstrate the use of a laser 

speckle to measure the velocity of a fluid flow. In 1977, Barker and Fourney, Dudderar and 

Simpkins, and Grousson and Malick each successfully measured the parabolic velocity profile in 

a laminar tube flow. The experimental setup was similar to a modern PIV system. The 

experiments used double-exposure photographs and a laser light sheet to capture the movement 

of particles in the flow. In 1983, Meynart achieved the first use of laser light to measure flow 

velocities for laminar and turbulent flows in both liquids and gasses. This work was given the 

term Laser Speckle Velocimetry (LSV), but the images produced usually depicted individual 

particles in a flow, rather than a laser speckle. Continuing efforts led to the modern concept of 

PIV (Adrian 1984, 2005).  

 In the mid 1980’s, many researchers began using PIV as a means of studying turbulent 

flow. This focus on turbulence significantly impacted the development of the PIV method. 

Researchers needed a measurement technique that could capture a wide, dynamic range of 

velocities within the same flow. They also needed a system that could handle randomness, didn’t 

rely on a set direction of flow, and could operate accurately at high Reynolds numbers (Adrian 

2005). All of these needs combined with the necessity of small particles (a few microns in 

diameter) led to the use of high intensity, pulsing lasers for particle illumination.   
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 As PIV continued to develop as a reliable measurement technique, the challenges began 

to shift from the data analysis to optimization of the image capture systems. The transition from 

film to digital imaging we especially helpful for PIV, as the rate of image (and subsequently data) 

capture was far beyond anything achievable with traditional film cameras. When digital imaging 

was first used by Nishino et al. (1989), a recording of 19,200 image pairs produced the most 

statistically significant PIV data for turbulent flows to that date. Furthermore, digital imaging 

allowed image pairs to be recorded with less time between images, allowing data collection in 

higher velocity flows. It was this advancement that pushed PIV into mainstream usage in the 

research community, and made it into the measurement method that it is today (Adrian 2005). 

2.2 Types of PIV 

 This review focuses on the most commonly used PIV methods: 2-D PIV (or simply PIV), 

stereoscopic PIV, tomographic PIV, and holographic PIV. All variations of the technique share 

certain components. These include a double-oscillating Nd:YAG laser, double-exposure cameras 

with at least 1 million pixels (1000 by 1000 pixel capture), and an external timing device that 

synchronizes the laser pulses with each exposure for the camera(s). A graphic depicting the 

capabilities of each system can be seen in Fig. 3 from Scarano (2013):  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Figure 3: Capabilities of PIV Methods (Reprinted from Scarano 2013) 

The ability to measure flow velocities based on space rather than time allows for a wide array of 

flow measurements that were previously difficult and/or impossible to measure, particularly in 

turbulent flows. Depending on the flow being analyzed, it is even possible for some PIV systems 

to capture the material derivative of velocity in a flow, thereby incorporating the benefits of 

systems such as LDA into a non-intrusive method of flow measurement (Scarano 2013). 

2.2.1 2-D PIV  

 2-D PIV is the simplest form of PIV and has been well-established since the 1980’s. A 

standard 2-D system uses a single camera aligned normal to a pulsing laser sheet that illuminates 

seed particles (Wereley 2010). The exact laser power required to achieve sufficient illumination 

depends on the type of particle and the distance between the laser head and the region of interest. 
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As such, researchers must optimize the laser power for each experiment. A standard 2-D PIV 

setup can be seen in Fig. 4: 

Figure 4: 2-D PIV Setup (Reprinted from Raffel et al. 2018) 

 While Fig. 4 provides a standard setup, the optics used are specific to each facility. It is 

important to note that the field of view (outlined in red) must be smaller than the laser sheet so 

that the entire image field produces data. If the images taken have voids or inhomogeneous 

seeding, bias errors are introduced into the data analysis (Westerwheel 2000). The imaging optics 

shown in Fig. 4 are usually simply the camera lens optics. In general, imaging systems that 

include additional optical lenses lead to larger perspective distortions, which can skew results in 

2-D PIV. Thus, most systems use fixed-zoom camera lenses without additional optics to 

minimize the distortions incurred for each image.  
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2.2.2 Stereoscopic PIV 

 Stereoscopic PIV (SPIV) is a more advanced style of PIV measurement that provides the 

out-of-plane velocity in addition to the the two in-plane velocities provided by 2-D PIV. This is 

accomplished using a pair of cameras installed at an angular offset from a plane normal to the 

illuminated plane. The two cameras produce two different simultaneous image pairs that are use 

to calculate the three-dimensional flow field in the experimental region of interest (Prasad 2000). 

Because the angle between the cameras and a plane normal to the laser sheet are known, the  

out-of-plane velocities can be determined based on the vector projections of each particle’s 

velocity in both images. The results from each set of pictures are then analyzed and combined to 

produce the velocity field in the experimental region of interest. A comparison image of 2-D and 

stereoscopic PIV setups can be seen in Fig. 5: 

Figure 5: Comparison of 2-D and Stereoscopic PIV  
(Reprinted from LaVision https://www.smart-piv.com/en/products/flowmaster/2d-stereo-

piv/ 2019) 
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 The SPIV system shown in Fig. 5 includes schiempflug mounts that offset the camera 

CCD planes from the lens planes. This is not required for successful SPIV. However, 

schiempflug mounts can significantly expand the system’s usable field of view and region of data 

accuracy by maintaining focus across the entire object plane (i.e. the illuminated laser sheet). 

Without these mounts, basic SPIV systems using a narrow depth of focus will produce images 

that are slightly out of focus because the subject of the image varies in distance from the camera. 

To remedy these issues, SPIV setups without schiempflug mounts use a smaller aperture to 

produce a large depth of focus and ensure the entire image remains in focus. This can be 

effective but smaller apertures result in less light capture which can lead to poor particle 

illumination. 

 Regardless of the lens setup, SPIV systems must be calibrated with specialized 

calibration targets to ensure the flow is accurately represented (Wieneke 2005). Calibration 

targets include dimensioned marks and/or features that are used to calculate the pixel scale 

(pixels per unit length) in the recorded images. Using calibration plates, multiple images must be 

obtained at different locations. Alternatively, stepped blocks or volumes with other dimensioned 

3-D characteristics can be sued to calibrate the system without having to capture multiple images 

or move calibration instruments (Soloff et al. 1997).    

 While stereoscopic PIV is capable of measuring out-of-plane velocities, the out-of-plane 

component is known with substantially lower accuracy than the in-plane components. This is 

because SPIV operates with a thin laser sheet rather than an illuminated volume. With this planar 

setup, SPIV systems calculate the out-of-plane velocity based on the angles between the cameras 

and normal to the laser sheet and the in-plane velocities. Because the out-of-plane velocity 
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results, essentially, from the difference of the two camera’s results, measurement uncertainties 

are larger than the in-plane velocities which are essentially the mean of the two camera’s results. 

The out-of-plane measurements accentuate measurement uncertainties while the in-plane 

measurements reduce measurement uncertainty. 

2.2.3 Tomographic PIV 

 If all three components of velocity require equivalently high accuracy, 3-D PIV systems 

such as tomographic PIV are necessary (Buchner et al. 2011). This produces a tradeoff between 

the accuracy of results versus the amount of time spent in system setup and data analysis. Thus, 

the decision to use stereoscopic or tomographic PIV must be made for each experiment, 

depending on the level of detail needed and the amount of time available for data reduction. 

Tomographic PIV is a much more complicated version of PIV that uses multiple cameras 

surrounding an illuminated volume that captures three-dimensional flow characteristics with 

equivalent accuracy across the entire volume in all three directions. The major distinction 

between stereoscopic and tomographic PIV is the evolution from a laser sheet to an illuminated 

volume of interest in the flow. Work by Elsinga et al. (2005), Scarano (2012), and Buchmann 

(2012) suggests that the illuminated volume requires a depth at least 1/4th the width of the field 

of view. This is accomplished by a combination of optics that either expand a pulsing laser beam 

into a laser sheet and subsequently into a rectilinear volume or expand a pulsing laser beam 

directly into a cylindrical laser volume. The optical setup used is largely dependent on the 

phenomena being measured and the capabilities of the facility conducting the experiment. In 
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order to capture sufficient data for each particle in the flow, tomographic systems are equipped 

with at least four synchronized cameras that capture double-exposure images of the volume of 

interest at the same time. A depiction of a typical tomographic PIV setup can be seen in Fig. 6:  

Figure 6: Tomographic PIV Setup (Reprinted from Buchmann et al. 2012) 

Figure 6 shows the complexity of a tomographic PIV system is far higher than a 2-D or 

stereoscopic system. Alignment of each camera is critical for successful data collection and this 

makes application to large-scale facilities particularly challenging. As described above, large-

scale tunnels inherently produce stronger vibrations and mechanical flexure than smaller-scale 

tunnels and these effects can significantly alter the alignment of the cameras when the tunnel is 

in operation. In small-scale environments, this can be alleviated by attaching the tomographic 

PIV setup to a fixed frame that ensures the relative positioning of the cameras and optics remain 

constant. However, such fixed frames aren’t feasible in large-scale facilities, as the test section is 
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too large to accommodate a single frame that is sufficiently rigid to ensure a common, fixed 

frame for the entire PIV system.  

 In addition to setup challenges, tomographic PIV also has a significantly more 

complicated and time consuming data reduction requirements. The major bottleneck is the 

number of voxels (3-D pixels) to be analyzed. The exact number can vary depending on the 

cameras being used, but it is not uncommon to process billions of voxels in each iteration 

(Scarano 2012). Oftentimes, weeks or months of data processing are required after a test before 

results can be obtained. As a result, researchers are working to develop new algorithms to 

expedite the process (Worth and Nickels 2008, Atkinson et. al 2008, Atkinson and Soria 2009).  

2.2.4 Holographic PIV 

 Holographic PIV is the newest and most complicated version of PIV. Similar to 

tomographic PIV, the holographic PIV is capable of resolving 3-D flow characteristics and Meng 

et al. (2004) claim is the most accurate method of doing so. However, this accuracy comes at a 

cost. Various complexities make the system much more difficult to set up and use compared to 

other techniques (Schäfer and Schröder 2011). A diagram of a typical holographic PIV setup can 

be seen in Fig. 7:  
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Figure 7: Holographic PIV Setup (Reprinted from Schäfer and Schröder 2011) 

The key difference between Figs. 6 and 7 is the increase in complexity within the optical system. 

Holographic PIV captures images of a holographic projection of the region of interest rather than 

directly imaging particles in the flow. The system uses a complex array of optics to replicate the 

region of interest in a scaled hologram which is then analyzed normally. This enables deeper 

experimental volumes to be studied than tomographic PIV. However, Schäfer and Schröder 

(2011) explain that in addition to the method’s inherent complexity, holographic PIV lacks the 

ability for online measurements, meaning that image focus and data validity cannot be assessed 

for hours after an experiment, a challenge that is also present with tomographic PIV setups. This 

can limit test cadence because the best experimental practice would be to verify successful data 

capture before adjusting the setup to make additional test runs.  
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2.3 Challenges of Large-Scale PIV 

 The principal concern of this thesis is application of PIV methods to large-scale, 

production-type wind-tunnel testing. Thus the continuing focus of this review will be 2-D and 

stereoscopic PIV that are currently most realistic for application in that context. Some of the 

challenges detailed here are solvable at the cost of time in calibration, alignment, or data 

reduction. This time can be a deterrent to PIV use in production environments where testing is 

often tightly constrained by schedule and the cost of tunnel occupancy. 

2.3.1 Physical Setup 

 One of the inherent challenges to scaling PIV systems for use in large-scale facilities is 

hardware implementation. Small-scale tunnels enable cameras and laser sources to be placed 

relatively close to the region of interest which makes measurements fairly easy to capture 

(Westerwheel et al. 2013). Implementing a PIV system in a large-scale facility forces hardware to 

be much farther from the region of interest and this leads to several issues. First, higher zoom 

lenses are required to capture particle flow. When the camera is moved farther from the 

experimental region of interest, either a variable-zoom lens or a lens with a higher fixed 

magnification is required. In either case, the additional optics within the lens lead to image 

distortions. Alvarez et al. (2012) show that these distortions can be modeled and corrected, a 

functionality that has since been added into most standard PIV computing softwares. Variable-

zoom lenses in particular produce significant distortion due to the additional optics contained 

within the lens (Li & Lavest 1996). 
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 PIV systems in large-scale environments must also contend with increased mechanical 

vibrations and mechanical flexture. In small-scale wind tunnels, most components are essentially 

rigid because of their small size. However, large-scale wind tunnels tend to be more flexible 

because of the longer lengths of the various structural members. This leads to larger steady 

mechanical flexure when the tunnel is in operation and there is a static pressure difference 

between the test section and the surroundings. The more-flexible structures can also have lower 

natural frequencies that are more apt to vibrate during testing. These two effects present a major 

challenge for PIV because precise alignments are critical to accurate data collection. Vibrations 

can influence the alignment of the PIV cameras, laser, and optics, and this makes the calibration 

scheme for large scale facilities much more complex (Raffel et al. 2004). Specifically, vibrations 

encountered in large scale facilities can change the location of the camera during image capture, 

changing the field of view for the first and second exposure. This results in an incorrect velocity 

measurements because particles appear to have all shifted due to the vibration, not just because 

of the actual motion of the flow. Similarly, vibrations can move the optics generating the laser 

sheet and change the plane of the flow being observed. This introduces a particle shift between 

images and can also illuminate particles outside the depth of focus for the camera. If this occurs, 

data analysis either cannot be completed or produces data that is unreliable. In either case, 

vibrations can be minimized through mechanical damping and/or be accounted for in data 

analysis. However, there will always be an additional error not present in small-scale tests 

(Raffel et al. 2004).  

 Another concern in large-scale PIV implementation is the selection and use of proper 

seeding particles. In small-scale applications seeding can be straightfoward as there are a wide 

!23



variety of usable tracer particles and only small amounts of tracer are typically needed. The 

traditional approach is to flood the wind tunnel with these particles to create a homogeneous 

distribution of particles that properly follow the flow (Towers et al. 1991, Westerwheel et al. 

2013). However, saturating large-scale wind tunnels with particles can be impractical due to the 

amount of particulate required. Depending on the particle selected, flooding the tunnel may be 

prohibitively expensive and could potentially have adverse health effects (Raffel et al. 2018). 

Extra attention must also be paid to the size of the individual particles in relation to the 

individual pixel size of the camera. If the particles are smaller than the dimensions of the pixels, 

the positions of each particle are approximated to the closest pixel which leads to significant 

errors. Moreover, very small particles will often not be adequately illuminated for reliable 

imaging. Kähler et al. (2012) shows that the best practice is for individual particles to have a 

diameter of 2.5 pixels or larger. This is possible in small-scale configurations with small regions 

of interest but large scale applications cannot attain this ratio while using particles that are 

sufficiently small to follow the flow. The two of these size constraints create a bounded region 

where the seeding particle selected must be sufficiently large to appear in the image pairs and 

receive sufficient illumination, while remaining small enough to accurately follow the flow. 

2.3.2 Image Capture and Analysis 

 The relationship between camera resolution and the large field of view in a large-scale 

wind tunnel introduces a significant challenge to successful use of PIV. As the desired field of 

view increases, either the resolution of the cameras being used for PIV must increase or the size 
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of the seed particles must increase. As discussed previously, increasing the seed particle size is 

not feasible, as the particles must be small enough to accurately follow the flow (Zhang et al. 

2003). Therefore, increasing the resolution of the camera is the best way to achieve a larger field 

of view. However, this can be somewhat difficult and expensive to accomplish with a single 

camera because resolution must be increased while keeping the dimensions of each pixel as low 

as possible (Kähler et al. 2012). Previous experiments with increasing PIV field-of-view at 

NASA Langley have used high resolution cameras to take images that are 4008 x 2672 pixels, 

and capture approximately half the model used (Jenkins et al. 2009).  These cameras have square 

pixels that are 9.0 microns by 9.0 microns, and represented some of the more cutting edge 

cameras at the time. An approximated field of view can be seen in figure 8, where lengths are 

normalized by vehicle wingspan, b:  

Figure 8: 14 x 22 Foot Test Section Field of View (Reprinted from Jenkins et al. 2009) 

The largest field of view captured in this experiment was 1.5 meters by 0.9 meters, which is 

much larger than most PIV applications. Based on this experiment, it appears that increasing 

camera resolution is a viable strategy for large-scale PIV implementation. However, it should be 

noted that increasing camera resolution is somewhat limited by the technology currently 
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available. One possible solution is the implementation of multiple cameras capturing individual 

images that can be stitched together during data analysis to artificially capture a larger field of 

view, but there have not been enough attempts at this method to confirm its efficacy.  
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3. SYSTEM DESIGN, VERIFICATION, AND TESTING 

 Chapter 2 provided an in-depth review of PIV as a measurement technology, and outlined 

the major issues facing PIV implementation in large-scale facilities. This chapter details the 

design, manufacture, and validation of systems to overcome these challenges and implement PIV 

in a large-scale production environment.  

3.1 PIV Frame Design and Manufacture 

 Repeatability is critical to the successful implementation of PIV in a production testing 

environment. As discussed in the Chapter 2, there are a variety of physical setup concerns that 

can decrease the repeatability of measurements in large scale wind tunnels, especially when 

operating at high speeds. Mechanical vibrations in large scale tunnels make unanchored 

mounting systems insufficient, as cameras are not anchored in a fixed position throughout the 

test. Furthermore, temporary mounting systems such as tripods cannot be reliably located in the 

same position relative to the test section on every setup, and can be accidentally bumped or 

moved by operators during testing. As a result, a method for rigidly locating the PIV cameras 

relative to the test section as deemed critical for the success of PIV in a production wind tunnel 

testing environment. At first, a list of requirements for the mounting system was developed. To 

be deemed effective, the system must: 

1. Be removable when not in use 

2. Provide rigid and repeatable positions for the PIV cameras  

3. Allow configuration of camera height, yaw, and streamwise position  
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To meet these requirements, a mounting frame design was selected, manufactured, and 

implemented at the LSWT. A photograph of the system installed on the test section front window 

is given in Figure 9.  

Figure 9: PIV Mounting Frame 
  

 The frame is made of extruded aluminum with T-slots along all sides. The upper and 

lower rails are fixed to the outer wall of the test section with aluminum angle brackets and bolted 

in place to ensure a rigid connection. The mounting beams on the left and right sides may be 

moved along the rails in the streamwise direction to allow image capture at any point in the test 

section. This can be easily done by loosening bolts connecting the interior gussets to the T-slot 

nuts and sliding the mounting beams into the desired position. Tightening the bolts ensures that 

camera position in the streamwise direction remains fixed relative to the test section, as long as 

the frame does not become detached from the tunnel.  

 The camera mounts are machined of stock aluminum. A detailed image of the mount 

design can be seen in Figure 10. The camera mounts are made entirely of machined aluminum 
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and assembled with standard english fasteners. The locating pocket and walls ensure the camera 

position within the mount remains fixed. Discrete angle selection holes allow rapid selection of 

standard camera angles depending on the holes used to bolt the camera mount together. 

Additionally, the system has a central bolt hole that may be used to set each camera at a custom 

angle if needed. The full mounting bracket is attached to the mounting beams with bolts that run 

into T-slot nuts in the inside grooves of both beams. Holes along the height of the mounting 

beams allow for a locating pin that sets a discrete height for the cameras. It is important to note 

that these pins are optional, and the camera mounts can be fixed at any point along the mounting 

beams by tightening the bolts when the mount is at the desired height. Overall, this system 

ensures that camera position remains fixed relative to the test section, ensuring repeatability 

between subsequent runs and tests. Flexibility of camera position is also maintained should other 

camera positions be needed.  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Figure 10: PIV Camera Mount  

3.2 PIV Uncertainty Maps and Post-Processing Explanation 

 Upon completion of post-processing, a time-average vector field was computed from all 

image pairs at each nominal velocity. DaVis 8.4.0 calculates the standard deviation of the 

measured x and y-direction velocity at each point in field using the sequence of instantaneous 

velocity values measured at each point. The standard deviations are then used to compute the 

uncertainty of the time-average velocity at each point in the field as the standard error of the 

mean: 

!30



in which S is the uncertainty of the mean velocity value, σx is the standard deviation at a given 

point, and N is the number of velocity vectors measured at that point. It should be noted that N 

can vary from point to point because every image pair does not necessarily capture an 

instantaneous velocity vector at every single point in the region of interest. Moreover, some 

instantaneous vectors are rejected during post processing. When the calculation is completed 

across the full average vector field, an uncertainty plot based on position within the region of 

interest can be produced. Plots for the 100 mph nominal freestream case with the 2-D and 

Stereoscopic PIV systems can be seen in figures 11 and 12. Additionally, Figures 13 and 14 

break down the uncertainty for in-plane and out-of plane velocities captured during 100 mph run 

of the out-of-plane velocity validation test discussed in section 3.4.  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Figure 11: 100 mph 2-D freestream Velocity Uncertainty Field 
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Figure 12: 100 mph Stereoscopic PIV freestream Velocity Uncertainty Field  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Figure 13: 100 mph Stereoscopic PIV In-Plane Velocity Uncertainty Field  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Figure 14: 100 mph Stereoscopic PIV Out-Of-Plane Velocity Uncertainty Field  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Once all image pairs were processed, each individual vector field went through two rounds of 

post processing with the application of consistency filters. First, a filter to eliminate spurious 

vectors was applied. The vector field for each image pair was scanned for spurious vectors 

whose magnitude fell outside a specified tolerance band. A significant degree of trial and error 

was used to determine the final tolerance band size, with the wake rake measured velocity ± 5  

m/s eliminating a majority of the most extreme errors. Erring towards a large tolerance band was 

preferable, as the inclusion of some spurious vectors was far better than the omission of non-

spurious results. This operation produced vector fields with small holes or gaps in data which 

were then backfilled via interpolation. The vector fields for all image pairs were then averaged 

together to produce a single average vector field. 

 After averaging the vector fields together, a second post-processing step was applied to 

eliminate the effects of particles entering or leaving the region of interest between image frames. 

This produces a small region of invalid data near the edges of the region of interest that must be 

removed in order to properly determine the efficacy of the PIV system. This was accomplished 

by the addition of a bounding box that cut all edge effects from the final average vector field. 

The bounding box was individually tailored to the dataset analyzed, and was sized to eliminate 

the edge effects with minimal elimination of viable data. Figures 15 and 16 show the before and 

after effects of post processing on measurement uncertainty for the 100 mph freestream 

stereoscopic PIV case.  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Figure 15: 100 mph Stereoscopic PIV Out-Of-Plane Velocity Uncertainty Field  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Figure 16: 100 mph Stereoscopic PIV freestream Velocity Uncertainty Field  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This capability is incredibly helpful when determining the appropriate bounding region or 

elimination of spurious values, as it provides a clear depiction of what data is highly accurate and 

what data must be disregarded during data analysis. The 2-D PIV velocity Uncertainty field 

shows that measurement uncertainty is relatively constant across the full image, with an increase 

in error at the left and right sides of the image. This increase is expected for any PIV system due 

to particles entering and leaving the field of view between images. Applying a bounded region to 

the dataset that omits the edges of each vector field eliminates these regions of higher 

uncertainty, providing the final data. In cases where the edges of the frame must remain in the 

image (i.e. to show the trailing edge of a wing or tail as done in the WB-57 tests in chapter 4), 

researchers must be mindful that measurements near the edges of the image will have a higher 

uncertainty due to these edge effects.  

 The Stereoscopic PIV uncertainty fields provide similar insight to the 2-D PIV velocity 

field, showing the increase in measurement uncertainty moving out from the center of the image. 

While some of the uncertainty at the edges of the image is still due to edge effects, the major 

cause of uncertainty in this setup is the variation in image focus from the center to the edges of 

each image. Without schiempflug adapters, focus will naturally vary slightly from the center of 

the images to the other, increasing the uncertainty of individual particle positions. This carries 

over into the processed data, where less focused areas within the image produce data with higher 

uncertainty. Similar to the 2-D case, the application of a bounding region eliminates the regions 

of high uncertainty and produces the final data. Once again, in cases where the edges of the 

frame must remain in the image (i.e. to show the trailing edge of a wing or tail as done in the 

WB-57 tests in chapter 4), researchers must be mindful that measurements will be most accurate 
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at the center of the image, with increasing uncertainty moving towards the left and right extremes 

of the vector field.  

 Of course, these uncertainty maps do not provide a comparable uncertainty to the values 

measured by the wake rake in this experiment. In order to determine the uncertainty of the PIV 

system measurement as a whole, the uncertainty equation from Schiacchitano and Wieneke 

(2016) must be used again to produce a single uncertainty for the full vector field. This is 

accomplished by using the mean velocity, standard deviation, and number of vectors within the 

average velocity field to produce a single uncertainty value for the full field. This method was 

used to produce the uncertainty values for the PIV systems catalogued in Tables 1-3. 

3.3 2-D PIV System Validation 

 After the selective seeding system performance was verified, the 2-D PIV system was 

validated against conventional wind-speed measurements to validate the PIV system. In order to 

minimize the number of systems tested, all PIV system validation was conducted with a flooded 

test section. The PIV system captured data in the center of the test section at a height of 45 

inches. This ensured the freestream velocity was unaffected by any possible flow anomalies 

caused by the wake rake or traversing mechanism and also minimized any wall effects 

experienced in the test section. During each run, PIV and pressure data were simultaneously 

collected in 12 second cycles and converted to velocities. Pressure data was collected with a 

wake rake and converted to velocity measurements. An example test setup can be seen in figure 

17, with the red rectangle denoting the region of interest location and the red oval outlining the 

wake rake. 
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Figure 17: Example Validation Test Setup 

During collection, one image pair was processed immediately to ensure image quality, with the 

remaining image pairs being stored for later processing. Validation data was collected for at 25 

mph, 50 mph, and 100 mph to verify the system’s accuracy at a wide range of velocities. A total 

of 1035 image pairs were captured across 3 runs and analyzed using DaVis 8.4.0 software. The 

data for each run was first analyzed with a cross correlating PIV scheme, beginning with a 64 

pixel x 64 pixel interrogation window. After the initial pass, three passes with a 32 pixel x 32 

pixel interrogation window were made to achieve higher measurement detail.  

 All data was post-processed using the methodology detailed in section 3.2. The changes 

to the average velocity field with the discussed post-processing steps can be seen in  Figures 

18-20: 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 Figure 18: 2-D PIV 100 mph Average Vector Field before Post-Processing 
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Figure 19: 2-D PIV 100 mph Average Vector Field with Consistency Filter 
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Figure 20: 2-D PIV 100 mph Average Vector Field with Bounding Box 
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These plots show that during the 100 mph test, the velocity measured by the 2-D PIV system 

varies by approximately ± 0.2 m/s (0.4%). Figures 18 and 19 show this variation with the slight 

change in color in the green regions of the plots. It should be noted that values located on the 

edges of each figure are spurious results due to particles entering or leaving the region of interest 

between images. A full breakdown of the measurement uncertainty for the 2-D PIV system can 

be seen in Table 1:  

Table 1: 2-D PIV System Percent Error 

 This data shows that the error of the 2-D PIV system implemented at the LSWT is below 

0.5%. Depending on the source, the average uncertainty for PIV is usually cited at or slightly 

below 1% (Wilson and Smith 2013), demonstrating that the system produced through this thesis 

meets or exceeds the current technology standards for PIV as a measurement technique. Thus, 

implementing PIV will be advantageous for the elevated standards for data accuracy and 

precision curated at the LSWT.  

Nominal Operating Velocity Wake Rake Velocity (mph) 2-D PIV Velocity (mph)

25 mph 11.5 ± 0.2 11.5 ± 0.1 (0.4%)

50 mph 22.6 ± 0.2 22.6 ± 0.1 (0.1%)

100 mph 44.8 ± 0.2 44.7 ± 0.2 (0.4%)
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3.4 Stereoscopic PIV System Validation 

The Stereoscopic PIV system was also validated against data from the wake rake and the 14-hole 

probe to determine its measurement accuracy. As before, the PIV system captured data in the 

center of the test section at a height of 45 inches and used 12-second pressure samples. Also as 

before, one image pair was processed during data collection to ensure image quality, with the 

remaining image pairs being stored for later processing. Validation data was collected for at 25 

mph, 50 mph, and 100 mph. Data collection during the out of plane verification runs followed a 

similar format, but used the angle of the laser sheet to calculate in-plane and out-of-plane 

velocity components to compare with the results of PIV. After data was collected, DaVis 8.4.0 

was again used for analysis and post-processing. The data for each run was first analyzed with a 

cross correlating PIV scheme, beginning with a 64 pixel x 64 pixel interrogation window. After 

the initial pass, three passes with a 32 pixel x 32 pixel interrogation window were made to 

achieve higher measurement detail. 

 All data was post-processed using the methodology detailed in section 3.2. The changes 

to the average velocity field with the discussed post-processing steps can be seen in Figures 

21-23.  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  Figure 21: Stereoscopic PIV 100 mph Vector Field before Post-Processing  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Figure 22: Stereoscopic PIV 100 mph Vector Field After Consistency Filter  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Figure 23: Stereoscopic PIV 100 mph In-Plane Vector Field With Bounding Box  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These plots show that during the 100 mph test, the velocity measured by the SPIV system varies 

by approximately ± 0.2 m/s (0.4%). Figures 21-23 show this variation with the change in color in 

the green sections of the plot. It should be noted that values located on the edges of the post-

processed image are spurious results due to particles entering or leaving the region of interest 

between images. The dramatic improvement in data quality from figure 21 to figure 23 

demonstrates the importance of effective post-processing for PIV data analysis. Consistency 

filters effectively removed erroneous values that were altering the velocity field and produce a 

much more accurate velocity field in the region of interest. These erroneous vectors can be 

attributed to two main factors. First, particles entering and leaving the region of interest create an 

edge effect of spurious results around the full image. This phenomenon is consistent with the 

challenges experienced with 2-D PIV, and can be seen in the SPIV vector field in figure 22 after 

the consistency filter has been applied. Second, the large regions of spurious vectors in figure 21 

are caused by the variation of focus from left to right for each camera. Since SPIV uses angled 

cameras to capture the out-of-plane velocity, the subject of each image has a varying distance 

from the camera. As such, each camera is most focused at the center of the image, with slightly 

degraded focus towards the edges. This can be alleviated with the addition of schiempflug 

mounts to the camera setup as discussed in Chapter 2, an addition that would decrease system 

dependence on the consistency filter and increase accuracy. A full breakdown of the 

measurement uncertainty for the SPIV system can be seen in Table 1.  

 Upon completion of post-processing, an average vector field was computed from all 

image pairs at each velocity. The average velocity across this field was then obtained and 
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compared against the average freestream velocity reported by the wake rake to determine the 

percent error of the in-plane velocity measured by the stereoscopic PIV system. The data 

comparisons for the in plane velocities can be seen below:  

Table 2: Stereoscopic PIV System In Plane Velocity Percent Error 

To quantify the accuracy of out of plane velocity measurements made by the stereoscopic PIV 

system, the laser sheet was angled across the freestream direction at a defined angle. This 

allowed a decomposition of the freestream velocity in the test section to in-plane and out of plane 

components. A diagram of the test setup can be seen in figure 24.  

Nominal Operating Velocity Wake Rake Velocity (mph) Stereoscopic PIV Velocity 
(mph)

25 mph 11.5 ± 0.2 11.5 ± 0.1 (0.1%)

50 mph 22.7 ± 0.2 22.7 ± 0.1 (0.2%)

100 mph 44.9 ± 0.2 44.8 ± 0.1 (0.3%)
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Figure 24: Stereoscopic PIV Out of Plane Velocity Test Setup  

A theoretical value for the out of plane velocity was calculated from the average freestream 

velocity measured by the wake rake during each run. This result was used as the baseline 

expected value and compared against the output of the stereoscopic PIV system to determine a 

percent error of the out of plane velocity measurement. The inputs and resulting uncertainties can 

be seen in table 3, and an example of the out of plane velocity field can be seen in figure 25. 

Table 3: Stereoscopic PIV Out of Plane Velocity Percent Error  

Nominal 
Operating 
Velocity

Laser 
Sheet 
Angle 
(deg)

Wake 
Rake 

Velocity 
(m/s)

Stereo  
In-Plane 
Velocity 

(m/s)

Out of Plane 
Velocity (m/s)

Stereo PIV Out 
of Plane Velocity 

(m/s)

25 mph 17.6 11.5 ± 0.2 11.5 ± 0.1 (0.3%) 3.5 ± 0.2 3.4 ± 0.1 (2.9%)

50 mph 17.6 22.6 ± 0.2 22.6 ± 0.1 (0.2%) 6.8 ± 0.2 6.6 ± 0.3 (4.7%)

100 mph 17.6 44.9 ± 0.2 44.8 ± 0.1 (0.2%) 13.6 ± 0.2 13.2 ± 0.4 (3.0%)
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Figure 25: Stereoscopic PIV 100 mph Out-of-Plane Velocities With Bounding Box 

 This data coupled with the freestream error analysis in Table 3 demonstrates the efficacy 

of the Stereo PIV system produced through this thesis. All in-plane velocity errors are below 

0.5%, maintaining the accuracy standard set with the 2-D PIV system. In fact, the average in-

plane velocity error for the Stereo PIV system is slightly lower than the error of the 2-D system. 

This is largely due to the dual camera aspect of Stereo PIV, which allows for correlation between 

the image pairs produced by each camera to decrease the error of the method.  
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 The out-of-plane velocity error of the Stereo PIV system also meets the accepted standard 

for measurement accuracy, maintaining an error below 5%. As discussed in Chapter 2, the out of 

plane velocity error of Stereo PIV is inherently larger than capturing the same measurement with 

a fully 3-D method (such as tomographic PIV) due to the planar nature of the light source used in 

a Stereo setup. However, out of plane measurements in wind tunnel tests are almost always  

dominated by the flow characteristics in the streamwise direction, making an error below 5% in 

out of plane measurements sufficient for most wind tunnel applications. Figure 21 also provides 

a strong example of the effect of varied focus on data quality in SPIV measurements. As 

discussed with the SPIV in-plane velocity fields, the variation of focus across images captured 

with SPIV introduces a degree of error that must be eliminated with either post-processing or 

additional hardware. Figure 25 shows the out-of-plane measurements are significantly impacted 

by the variation in focus, further demonstrating the importance of schiempflug adapters. With the 

current system available at the LSWT, the accuracy of out-of plane measurements is highest in 

the center of the image, with decreasing fidelity towards the edges of the region of interest. As 

discussed with figures 21-23, this can be mitigated with the inclusion of schiempflug adapters in 

the SPIV system, allowing the full image to be focused evenly.  

3.5 Seeding System Design and Manufacture 

 As discussed in Chapter 2, effective particle seeding is a tremendous challenge in large 

scale wind tunnel tests. To achieve effective seed particle density for PIV in large scale 

environments, selective particle seeding was a necessity. A list of system requirements were 
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developed and discussed with researchers at Arnold Air Force Base in the Engineering Design 

Complex (AEDC). The resulting list of requirements is as follows:  

1. Create a particle column at least 1 foot wide x 0.5 inch deep of sufficient density for 

successful PIV measurements 

2. Deliver the particle column anywhere from floor level to 5 feet above the floor and anywhere 

across the middle 5 feet of the test section 

3. Be configurable such that the particle column may be oriented vertically or horizontally in 

the test section OR deliver a 1 foot wide x 1 foot deep column 

4. Be sufficiently robust to safely enable q = 75 psf operation in the test section and provide a 

steady particle column position 

5. Be capable of installation and removal in less than 1 day (each) OR be sufficiently robust to 

remain permanently installed and enable operation up to q = 125 psf in the test section 

6. Create no more than a 1% wake velocity deficit in the test section 

7. Inject particles downstream of any screens or honeycomb to avoid fouling those flow-quality 

devices 

 Based on these requirements, a proof of concept particle seeding system was designed 

and implemented at the LSWT. The seeding system consists of a MDG Touring 5000 APS fog 

generator, a custom blower, and a custom seeding tube. The seeding tube matches the contour of 

a symmetric airfoil with a 3” diameter PVC pipe for the leading edge. Particles from the fog 

generator are piped into the seeding tube with the custom blower, and ejected from the leading 

edge through 0.25” holes. This produces a curtain of particles that travels downstream from the 
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settling chamber and through the region of interest to provide seeding without flooding the entire 

test section. Pictures of these components and a diagram of the full assembly can be seen in 

Figures 26-29. 

  

 Figure 26: MDG Fog Generator 
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Figure 27: Custom Blower Box (Lid Removed) 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Figure 28: Custom Seeding Tube Center Section (Proof of Concept Test) 
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Figure 29: Selective Seeding System Diagram 

 All components for the seeding system were manufactured on-site at the LSWT. The 

custom blower box is made of aluminum sheets and angle brackets. A blower fan is bolted inside 

of the box and is controlled with a variable transformer. The MDG fog generator is connected to 

the blower box via two 1 inch diameter pipes that are slip fit to the input holes on the box and 

taped to form a seal. A 2 inch PVC flex pipe connects the blower box output to the custom 

seeding tube, which consists of a 3 inch PVC pipe and a trailing edge of foamular 250 high 

density insulation foam. This section is connected to the the settling chamber with two specially 

designed connections for the floor and ceiling, as seen in Figures 30 and 31.   
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Figure 30: Selective Seeding System Ceiling Connection 

Figure 31: Selective Seeding System Floor Connection 

 The ceiling connection has three holes spaced 1 inch apart on the top of the PVC end cap. 

The center hole allows the attachment of a steel cable to an internal pin which allows the system 

to be lifted to the top of the tunnel via a winch system. The cable is inserted through a hole in the 
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top of the settling chamber and lowered to the floor, where it can be attached to the seeding 

system. The outer two holes are used to bolt the seeding system to the roof of the tunnel, with 

bolts originating inside the cap. When the seeding system is lifted into place, the bolts align with 

holes in the top of the settling chamber where they are each locked into place with a nut. The 

floor connection is designed to admit the PVC flex pipe and improve the configurability of the 

design. During installation, the two aluminum support blocks at the bottom of the system are 

removed to allow the assembly of the full seeding system. Once the ceiling connection is secure, 

the support blocks are bolted to the bottom of the system and then to the bottom of the tunnel. 

When coupled with the pinned connections between each section of PVC pipe, this design puts 

the full system in tension, helping to eliminate any vortex induced vibrations that could occur 

during testing.  

 The trailing edge foam of the seeding system was cut into a symmetric airfoil using a hot 

wire cutter. A wedge with a 140˚ interior angle was cut into the leading edge of the foam to 

provide two points of contact along the PVC pipe, and the foam was fastened into place with 

aluminum tape. Aluminum tape was used in place of a more permanent bond to allow testing 

with and without the trailing edge, as well as testing with particle distribution holes at varying 

angles relative to the trailing edge. The preliminary design can be seen in figure 32.  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Figure 32: Preliminary System Check Smoke Sheet 

 Based on the performance of the selective seeding system during preliminary system 

checks, the system was evaluated for performance against the requirements listed in table 2.  

3.6 Seeding System Validation 

 To verify that the selective seeding system met its flow quality requirements the velocity 

deficit caused by the system and the quality of seeding was evaluated. Its velocity deficit was 

measured with the seeding system installed and operating in the test section with a 10 mph flow. 
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This velocity was selected to simulate the anticipated velocity in the settling chamber during a 

standard 100 mph test. This installation was captured in figure 28. The wake rake was used to 

measure the velocity across the test section 3 feet behind the trailing edge of the seeding system. 

Multiple rake positions were combined to create the velocity deficit plot seen in figure 33.  

Figure 33: Selective Seeding System Velocity Deficit 3 ft Downstream 

This plot shows the velocity behind the seeding system is approximately 90% of the freestream 

velocity.  When the system is moved upstream of the contraction, the expected velocity deficit 

would significantly decrease due to transition upstream to the settling chamber. The increased 

distance from the seeding system to the region of interest coupled with the effects of the 10:1 
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contraction were estimated as sufficient to bring the wake velocity deficit in the region of interest 

below 1% of the freestream velocity in the test section. Based on this result, the design was 

moved to the settling chamber for further testing and evaluation.  

 To verify the structural stability of the system when installed in the 30-ft diameter settling 

chamber, a full model of the selective seeding system was designed and tested using the FEA 

package in Solidworks 2019. A drag coefficient of 0.2 was determined using the wake integral 

for the seeding system, and a lift coefficient of 0.1 was estimated based on the worst case 

alignment of the system during installation. These values were used to calculate expected loads 

for the selective seeding system at 10 mph and 20 mph. Both velocities were selected based on 

the design of the LSWT, which has a 10:1 contraction between the settling chamber and the test 

section. This means that a 10 to 20 mph flow experienced by the seeding system in the settling 

chamber corresponds to a 100 mph to 200 mph flow in the test section. No PIV tests would be 

conducted above 200 mph. The foam portion of the airfoil was included in the drag and lift 

estimates, but was not included in the FEA analysis. This is because the bond between the foam 

and the PVC pipe is not sufficient for a good transfer of stress. Thus, all loading on the system 

will be experienced by the PVC pipe in the leading edge of the seeding system. The connection 

between the seeding system and the floor of the settling chamber was modeled as a fixed 

connection, and the connection between the seeding system and the ceiling was modeled as a 

hinged connection. These particular interactions were selected based on the connections designed 

for each location. In total, four load cases were simulated as seen in Table 4. An example 

deflection plot for the 10 mph drag load case can be seen in figure 34.  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 Table 4: Seeding System Structural Evaluation  

Figure 34: 10 mph Drag Load Case: Deflection  

Load Case Applied Load (N) Maximum 
Deflection (mm)

Maximum Von 
Mises Stress 
(MPa)

Maximum Strain

10 mph Drag 1.7 3.1 1.4 4.4E-04

10 mph Lift 3.9 7.0 3.2 9.9E-04

20 mph Drag 6.9 12.5 5.7 1.8E-03

20 mph Lift 15.7 28.1 12.9 3.9E-03
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 This structural analysis confirmed the structural viability of the selective seeding system. 

PVC is commonly cited as having a yield stress of 55 MPa, well above the maximum yield stress 

experienced by the system. Furthermore, the maximum deflection of the system under any 

simulated load condition was 14 mm in the middle of the system. This deflection is small in 

comparison to the size of the system, so the aerodynamic properties behind the system are not 

expected to change under load. This all suggests the system is sufficiently rigid without 

additional support.  

 In addition to capturing the wake velocity deficit and estimating the loads on the selective 

seeding system, stereoscopic PIV data was taken behind the seeding system to verify the quality 

of smoke produced by the system. Seed particles were injected into the flow in short bursts, 

which were captured with the stereoscopic PIV system. All data was compiled and analyzed with 

DaVis 8.4.0 to ensure the seeding density was high enough to produce quality PIV data. An 

example set of images for the smoke quality test and the corresponding flow field can be seen in 

figures 35 and 36.  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Figure 35: Selective Seeding Smoke Quality Example 

Figure 36: Selective Seeding Smoke Quality Example Flow Field 
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This data shows the smokescreen generated by the system is of a sufficient quality to produce 

successful PIV data. Figure 35 shows a dense set of particles in the the region of interest that can 

be analyzed by the PIV software. This image can be taken as a best case image for selective 

seeding with the current system. During testing, it was noted that particle density in each image 

varied due to the non-homogeneous nature of the smoke column produced. As such, larger 

datasets are required to ensure the average velocity fields produced are accurate. The average 

velocity field produced from the smoke quality test in Figure 36 shows the flow accelerating as it 

moves away from the trailing edge (located 1 foot upstream of the depicted velocity field). This 

is expected near the trailing edge of an airfoil, demonstrating the selective seeding system's 

ability to produce smoke sufficiently dense for successful PIV measurements.  

 After verifying the velocity deficit and smoke quality of the seeding system, the full 

design was implemented in the settling chamber of the LSWT. Based on the configurable design 

of the system, the seeding section may be placed in the either the upper, middle, or bottom 10 

feet of the settling chamber during installation. An installation with the seeding section in the 

middle 10 feet of the settling chamber can be seen in figure 37.  

!68



Figure 37: Selective Seeding System (Installed) 

 In total, the full installation of the selective seeding system took 6.5 hours from start to 

finish during its first installation. This satisfies meeting requirement 7 as listed on page 55. The 

configurable nature of the system ensures that smoke can be delivered at any vertical position in 

the tunnel, satisfying requirement 2, and the placement of the system downstream of the vanes 

and screen in the settling chamber satisfies requirement 7. Additionally, due to the approximately 

constant diameter of the settling chamber, this system can be installed in either a vertical or 

horizontal orientation, satisfying requirement 3. It is important to note that horizontal installation 

in the LSWT necessitates the use of scaffolding both inside the settling chamber and outside the 

tunnel to fasten the system into place. Furthermore, each installation orientation requires a 

unique set of holes in the shell of the settling chamber. As such, the data for this thesis focuses 
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solely on data collected from a vertically-oriented installation, to minimize the number of holes 

created in the settling chamber and the acquisition of additional equipment.   

 After the system installation was complete, a second velocity deficit was taken with the 

system installed to ensure the velocity deficit met the 1% tolerance outlined in requirement 6. 

The validation was run at 75 mph, and produced the deficit plot in figure 38.  

Figure 38: Velocity Deficit With Seeding System Installed in the Settling Chamber 

This plot is very significant, as it confirms the expectation that the contraction between the 

settling chamber and the test section eliminates any measurable velocity deficit produced by the 

seeding system.  

 Finally, the smoke column produced by the seeding system had to be evaluated to ensure 

the smoke sheet generated was at least 1 ft tall by 0.5 in thick at any point in the test section.  
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This was accomplished by running the tunnel at 25 mph and capturing images of the seed 

particles passing over dimensioned instruments in the test section. The resulting images can be 

seen in figures 39-42. 

 Figure 39: Selective Seeding Column Height (Centered Particles) 

Figure 40: Selective Seeding Column Thickness (Centered Particles)  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Figure 41: Selective Seeding Column Height (Particles at Floor Level) 

Figure 42: Selective Seeding Column Thickness (Particles at Floor Level) 
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 These images demonstrate the ability of the selective seeding system to produce a 

sufficiently large column of particles to effectively conduct PIV measurements in a large scale 

environment. The centered particle column has a height well above the desired 1 ft measurement, 

and a thickness of approximately 8 inches. When the particle column is located near the floor, the 

height decreases slightly but remains at approximately 1.5 ft, with the thickness increasing to 1.5 

ft. In both cases, the seeding column produced by the system is well beyond the minimum 

dimensions listed in requirement 1 on page 55.  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4. APPLICATION EXAMPLES 

 Chapter 3 detailed the design, production, and validation of each individual system 

produced for this thesis. After completion of all validation steps, the systems were used for 

multiple tests at the LSWT to demonstrate viable use cases for the systems in future production 

level tests. Chapter 4 details the results of these application tests. 

4.1 HARS Flow Quality Test 

 This test serves as an application example for 2-D PIV with a fully seeded tunnel at the 

LSWT. In order to demonstrate effective implementation of 2-D PIV at the LSWT, the system 

was used to measure and evaluate the improvement in flow quality over the bullet of the High 

Attitude Robotic Sting (HARS). This system is used to mount a wide variety of models at the 

LSWT, and was recently redesigned to decrease the aerodynamic impact of the bullet on the tail 

end of models tested at the LSWT. Images of the old and new designs can be seen in figures 43 

and 44. 

Figure 43: Old HARS Bullet 
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Figure 44: New HARS Bullet 

The lower profile of the new design is intended to decrease the upflow angle near the tail of the 

model visible in figures 43 and 44. PIV data is intended to test this hypothesis. Capturing this 

data would be nearly impossible with the standard equipment at the LSWT due to the location of 

the region of interest, making the test an ideal application for 2-D PIV. Data was captured in a 

square region of interest aligned with the nose of the old HARS bullet design, two inches above 

the sting. This placement was selected to eliminate reflections from the sting in the final images, 

as well as capture the impact of each design on upflow angle near the location of the WB-57 tail 

when installed. A diagram of region of interest placement for both the old and new HARS bullet 

designs can be seen in figures 45 and 46.  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Figure 45: Old Bullet Region of Interest Placement 

Figure 46: New Bullet Region of Interest Placement 

Larger versions of the inset PIV data plots near the bullet are shown in figures 47 and 48, and 

corresponding velocity uncertainty plots can be seen in figures 49 and 50. These plots show a 

clear decrease in upflow angle with the design change, confirming the efficacy of the new 

design. In addition, this experiment demonstrates that the PIV system developed for use at the 
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LSWT can usefully quantify a 2-D velocity field in a region of interest, a capability that has been 

previously lacking at the LSWT. Additional information about these tests is given by Miller, 

Leber, Brown and White (2020).   

Figure 47: Old Bullet Nose Upflow Angle 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 Figure 48: New Bullet Nose Upflow Angle 
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Figure 49: Old Bullet Velocity Uncertainty Plot  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Figure 50: New Bullet Velocity Uncertainty Plot 

Figures 47 and 48 show a clear decrease in upflow angle near the nose of the bullet 

with the implementation of the new bullet design. 
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4.2 WB-57 3-D Flow Field Test 

 The second application example demonstrates Stereoscopic PIV using selective seeding. 

During normal operation, PIV measurements of both in-plane and out of plane velocities could 

be a desired output of the system. As such, stereoscopic PIV data was captured for both an angle 

of attack (alpha) sweep and a sideslip (beta) sweep to demonstrate the efficacy of the system.  

 The WB-57 is an aluminum model produced by the LSWT for a previous NASA test. The 

model is representative of many of the tests conducted at the LSWT. Images of the model can be 

seen in Figures 51 and 52. 

Figure 51: WB-57 Model (Side View)  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Figure 52: WB-57 Model (Rear View) 

  For this thesis, the WB-57 model was selected for the stereoscopic PIV application 

example to simulate a standard LSWT production level test. As discussed in Chapter 1, 

customers are often interested in the aerodynamic causes for loads output by the internal and 

external balances during tests. Conducting PIV for an alpha and beta sweep of the WB-57 

provides insight into the aerodynamics of the model as it approaches stall conditions.  

 The alpha sweep test was used to measure velocities above and behind the trailing edge 

of the WB-57 wing. Measurements were taken sufficiently close to the top surface of the wing 

such that data acquisition with existing equipment at the LSWT would not have been possible 

without disrupting the flow characteristics in the region of interest. To begin, an alpha sweep 

without PIV data was used to produce a lift coefficient versus alpha plot to determine the stall 

angle of the WB-57 model. The plot can be seen in figure 53.  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Figure 53: Lift Coefficient versus alpha for WB-57  

Based on this data, five discrete angles of attack were chosen that corresponded with five distinct 

flight conditions level flight (0˚ angle of attack), low angle of attack (2.5˚), moderate angle of 

attack (5˚), Stalled flight (10˚ angle of attack) and well beyond stall (15˚ angle of attack). These 

conditions were selected to provide insight into how the flow characteristics behind the WB-57 

wing change as the aircraft approaches and passes through stall. A diagram of region of interest 

placement can be seen in figure 54, and an approximate region of interest location on the real-

world model can be seen in figure 55. 
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Figure 54: WB-57 Alpha Sweep Region of Interest Placement 

Figure 55: Alpha Sweep Region of Interest on Real-World Model 

Each plot contains a black triangle the lower left corner that outlines the placement of the WB-57 

wing. The trailing edge of the wing intersects with the x-axis in each plot. Figures 56-60 give the 

progression through the alpha sweep, while figures 61-65 provide the corresponding velocity 

uncertainty fields. Streamlines are generated from streamwise (Vx) and vertical (Vy) velocities. 

Spanwise velocity (Vz) is depicted with a color contour, with positive Vz out of the page.  
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Figure 56: WB-57 0˚ AOA PIV Results 

Figure 57: WB-57 2.5˚ AOA PIV Results 
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Figure 58: WB-57 5˚ AOA PIV Results 

Figure 59: WB-57 10˚ AOA PIV Results 
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Figure 60: WB-57 15˚ AOA PIV Results 
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Figure 61: WB-57 0˚ AOA Velocity Uncertainty Plot  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Figure 62: WB-57 2.5˚ AOA Velocity Uncertainty Plot  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Figure 63: WB-57 5˚ AOA Velocity Uncertainty Plot  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Figure 64: WB-57 10˚ AOA Velocity Uncertainty Plot  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Figure 65: WB-57 15˚ AOA Velocity Uncertainty Plot  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As the model proceeds through the alpha sweep, PIV data provides two key insights. First, Vy 

becomes more negative over the trailing edge and behind the wing until stall is reached. This is 

consistent with the physics of how wings generate lift, with the flow following the curvature of 

the wing’s upper surface as closely as possible. Secondly, PIV data provides insight into how and 

when the flow separates from the upper surface of the wing. The PIV data shown above depicts 

the gradual growth of separated flow region with increasing angle of attack. When the model is 

beyond stall (the 15˚ angle of attack case), clear vortex structures behind the wing dominate the 

flow, representing full separation and turbulent flow behind the wing, all of which aligns with the 

currently accepted understanding of how flow separation occurs with increased angle of attack 

and aircraft stall. This is mirrored in the Vz measurements for each plot, which show a nominally 

0 out-of-plane velocity far from the surface of the wing. This value drastically changes when 

entering the turbulent section of the flow, depicted by the positive out of plane velocity near the 

wing. At a 15º angle of attack, the out of plane velocities are much less uniform, which is 

characteristic of flow behind a fully stalled wing. 

 Streamlines depicted in the 2.5˚, 5˚, and 10˚ plots have a slight discontinuity in the 

separated flow region near x = 1.5 inches. This is due to a scratch in the glass roof of the LSWT 

test section that blocked the portion of the laser sheet corresponding to this x location. The 

blocked portion of the data provided erroneous data, and was therefore removed in post-

processing and filled with the average of the values on either side of the gap. In the laminar flow 

regime, this did not significantly affect the streamlines or measured velocities, as the flow was 

largely continuous. However, the effects of the scratches can still be seen in the uncertainty plots, 

where higher uncertainty values near the center of the region of interest appear and then return to 

!93



the expected uncertainty of the system. This did not significantly impact the data collected in this 

particular test, but could negatively impact results in future tests. It should also be noted that as 

flow behind the wing becomes more turbulent, the overall uncertainty of measurements 

increases. This is due to the increase in the Vz component of the flow, which has a higher 

uncertainty than Vx and Vy due to the planar nature of Stereoscopic PIV measurements. Thus, as 

the magnitude of Vz grows at any point, the uncertainty of the velocity measured at that point 

increases. Regardless, the data produced by the PIV system provides valuable insight into the 

separation behind the trailing edge of the WB-57, and is a valuable application of the system for 

the LSWT.  

 The beta sweep test was used to measure velocities above and behind the trailing edge of 

the WB-57 vertical tail. Measurements were taken sufficiently close to the tail that data 

acquisition with existing equipment at the LSWT would not have been possible without 

disrupting the flow characteristics in the region of interest. Similar to the alpha sweep test, a 

preliminary run was conducted without PIV data to determine the sideslip angle corresponding to  

stalling the vertical tail of the WB-57. This was determined from the yawing moment coefficient 

versus beta plot shown in figure 66.  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 Figure 66: Yawing Moment Coefficient vs Beta for WB-57 

This plot shows that the vertical tail of the WB-57 stalls at a sideslip of approximately 15 

degrees. Based on this data, five discrete sideslip angles were chosen that corresponded with five 

distinct flight conditions level flight (0˚ sideslip), low sideslip (5˚), moderate sideslip (10˚), 

vertical tail stall (15˚ sideslip) and well beyond stall (25˚ sideslip). These conditions were 

selected to provide insight into how the flow characteristics behind the WB-57 vertical tail 

change as the aircraft approaches and passes through vertical tail stall. A depiction of the region 

of interest on the real world model can be seen in figure 67.  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Figure 67: Beta Sweep Region of Interest on Real-World Model 

Measurements for each flight condition were captured with both a traditional flooded tunnel 

approach and a selectively seeded approach to demonstrate the efficacy of both methods. Figures 

68-73 give the progression through the beta sweep, and figures 74-79 provide the corresponding 

velocity uncertainty plots. Streamlines are generated from streamwise (Vx) and vertical (Vy) 

velocities. Spanwise velocity (Vz) is depicted with a color contour, with positive Vz out of the 

page. It should be noted that data located directly above the vertical tail is not accurate, due to 

reflections off the upper surface of the vertical tail. These reflections oversaturate the images in 

the region over the tail, leading to spurious values of Vz.   

!96



Figure 68: WB-57 0˚ Sideslip Flooded PIV Results 

Figure 69: WB-57 0˚ Sideslip Selective Seeding PIV Results  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Figure 70: WB-57 5˚ Sideslip Flooded PIV Results 

Figure 71: WB-57 5˚ Sideslip Selective Seeding PIV Results  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Figure 72: WB-57 10˚ Sideslip Flooded PIV Results 

Figure 73: WB-57 10˚ Sideslip Selective Seeding PIV Results  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Figure 74: WB-57 0˚ Sideslip Flooded PIV Results 
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Figure 75: WB-57 0˚ Sideslip Selective Seeding PIV Results 
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Figure 76: WB-57 5˚ Sideslip Flooded PIV Results 
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Figure 77: WB-57 5˚ Sideslip Selective Seeding PIV Results 
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Figure 78: WB-57 10˚ Sideslip Flooded PIV Results 
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Figure 79: WB-57 10˚ Sideslip Selective Seeding PIV Results 
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 Each plot was aligned such that the top of the vertical tail of the WB-57 could be easily 

identified on the left side of the image. The exact placement of the vertical tail varies slightly, as 

the region of interest was shifted and recalibrated for each new sideslip angle. At low sideslip 

angles (0˚, 5˚ and 10˚), results closely match the expected flow characteristics behind the tail of 

the WB-57. The 0˚ cases depict linear flow with horizontal streamlines and a minimal Vz 

component which is expected when the tail is producing no sideforce. One interesting 

phenomena visible in both the flooded and selectively seeded cases is the presence of a small 

vortex along the streamline at y = 1.5 in. This small vortex lines up with the edge of the tape 

used on the aluminum model to prevent reflections, and its capture shows the sensitivity of the 

stereo-PIV system developed through this thesis. The 5˚ cases also provide a realistic depiction 

of flow coming off the tail, with a positive Vz component coming off the tail of the model that 

trends towards zero moving downstream from the model. Looking at the flooded case, the 

beginnings of a vortex at the top of the vertical tail can also be seen, with Vz moving into the 

page above and behind the top of the vertical tail. The selectively seeded image for this case 

differs substantially from the flooded case, depicting one of the potential pitfalls of selective 

seeding. In reviewing the dataset, the number of image pairs with sufficient smoke density was 

found to be lower in these images than the more successful selectively seeded runs at 0º and 10º 

sideslip. This shows that selective seeding is not perfect, and must be more carefully observed 

during testing to ensure smoke density is sufficient in each run. 

 In the 10˚ case, the vortex caused by the top of the vertical tail becomes more 

pronounced, while flow directly behind the tail maintains its positive Vz that trends towards zero 

downstream. At the right side of the flooded image, spurious vectors from another scratch in the 
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glass roof of the LSWT test section lead to a very negative Vz near the edge of the image. The 

same issue was present in the selectively seeded result, but was more effectively filtered out in 

post-processing. This suggests that to a point, higher particle densities help decrease the impact 

of minor system defects. 

 The 15˚ and 25˚ sideslip measurements were made but did not result in useful data. At 

both angles, the vertical tail is stalled and there is a large out-of-plane Vz. As such, a large 

number of particles leave the laser sheet between the first and second exposure of the cameras, 

resulting in a much lower fidelity dataset. This points towards a well-known issue with 

stereoscopic PIV as a measurement technique more than anything specific about the system 

developed through this thesis. As out of plane velocities in stereoscopic PIV setups approach the 

magnitude of the in-plane measurements, data accuracy drastically decreases due to the lost 

particles mentioned above. In these cases, a tomographic PIV setup would be preferable if a true 

3-D depiction of flow behind the tail was desired. Alternatively, a 90˚ rotation of both the laser 

sheet and the cameras about the x-axis would allow stereoscopic PIV to more effectively capture 

the vortices behind the vertical tail when it moves beyond stall. A more extensive explanation of 

future system improvements and suggestions can be found in Chapter 5.  

 The uncertainty plots also provide interesting insights into the efficacy of the selective 

seeding system. Each uncertainty plot demonstrates an increase in uncertainty with increased Vz 

in accordance with the WB-57 alpha sweep. However, these plots also show that uncertainty is 

higher in runs with selectively seeded PIV. This makes sense, as the lack of homogeneity during 

seeding means that there are fewer image pairs with seed particles available at any single point 

for the average velocity at that point. As a result, there are fewer vectors being used to calculate 
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the velocity uncertainty at any one point in the region of interest. Thus, the uncertainty for non-

homogenous, selectively seeded PIV will always be higher than flooded PIV datasets. 

 Overall, the results are sensible and consistent between the selectively seeded and 

traditionally flooded runs. This is very significant from a proof of concept standpoint for the 

selective seeding system, as it demonstrates that selective seeding can replace traditional seeding 

methods in large scale PIV setups. Accordingly, it is worthy of continuing development for use in 

large scale wind tunnels at facilities such as the Arnold Engineering Development Complex 

(AEDC) or the National Full-Scale Aerodynamics Complex (NFAC). In particular, the 

selectively seeded 5º sideslip case illuminates a path for future development of a new iteration of 

selective seeding that produces a smoke column of continuous homogeneous density.  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5. CONCLUSIONS AND RECOMMENDATIONS 

5.1 Conclusions 

 This thesis reports on the design, implementation, and use of hardware and procedures 

for both 2-D and stereoscopic PIV in the Texas A&M Low Speed Wind Tunnel. This includes the 

development of specially designed mounting hardware that facilitates the rapid and repeatable 

installation and execution of PIV that is vital to successful usage in a production environment. 

While these factors are already important in research applications, they may be more important 

in production environments where external customers run on a tight testing schedule and trust the 

data produced for critical design decisions. As such, the successful validation of the PIV system 

to an uncertainty of 0.5% in plane and 5% out of plane was a critical threshold for data quality. 

The PIV systems produced for the LSWT are fully validated and available for use upon 

conclusion of this thesis.  

 The selective seeding system has also performed well in proof of concept testing, meeting 

all design requirements. The lack of velocity deficit in the test section seen during the validation 

stages of testing and the comparable data to traditionally seeded data produced during the WB-57 

beta sweep are particularly encouraging because it suggests facility flow quality can be 

maintained in the presence of a selective seeding system. Furthermore, the relatively equivalent 

results from the selective seeding and flooded tunnel runs in the WB-57 beta sweep suggest that 

selective seeding in large wind tunnels is a viable alternative to traditional seeding methods. In 

some cases, selective seeding was even found to be more effective in eliminating spurious 

vectors due to the higher particle density produced by selective seeding. That being said, it 
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appears important to collect more image pairs when using selective seeding configurations than 

under flooded conditions, as the lack of seeding homogeneity remains a concern. Nevertheless, 

the method demonstrates a clear step forward for large scale facilities seeking to implement any 

type of PIV system.  

5.2 Recommendations 

 Looking ahead, continuing effort should address a few key development needs. First and 

foremost, improvements to selective seeding uniformity should be made as soon as possible. The 

implementation of the system is currently effective, but requires more image pairs and 

processing effort than a flooded tunnel approach. This is largely due to the lack of uniformity in 

the smoke column that is being generated which can produce datasets with insufficient particle 

density, leading to higher velocity measurement uncertainties. While this was not a hinderance in 

this particular thesis, continued implementation in production level environments necessitates 

further system improvement. 

 Second, image stitching to create larger fields of view should be investigated. With the 

current setup, PIV data can only be captured in a region of interest approximately 4 inches x 6 

inches. This could be somewhat expanded by acquiring higher resolution cameras or a large 

calibration card, but results with this method would be limited. The best avenue to a large field of 

view lies in stitching individual regions of interest together into a larger field of view. Of course, 

this could be accomplished by shifting the camera positions multiple times throughout a single 

test, but such an approach would be highly time consuming. Depending on the desired field of 
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view, acquisition of additional cameras to simultaneously capture multiple regions of interest that 

could then be stitched together could be the most viable approach.  

 The third incremental improvement for the LSWT would be the acquisition of 

schiempflug mounts for each camera used in the stereoscopic PIV system. These mounts offset 

the lens plane of the camera from the image plane, allowing cameras to capture focused images 

with a narrower depth of field. This will eliminate the need for extensive taping of reflective 

components behind the laser sheet, as the cameras can be more narrowly focused during 

calibration to capture exclusively the region directly illuminated by the laser sheet. At the LSWT 

this is particularly significant, as most models are made of either metals or 3-D printed materials, 

both of which are reflective surfaces. As such, taping is currently necessary to prevent data 

interference, making the process of PIV data acquisition longer than it should be. Additionally, 

schiempflug mounts would allow researchers to position the cameras at larger off-normal angles 

relative to the laser sheet. The current system is capped at a 20˚ off angle mount, as larger angle 

values decrease the fidelity of in-plane measurements. This improvement would significantly 

expand the capabilities of the LSWT, and enable data acquisition over a wider array of 

theoretical configurations.  

 Fourth, it will be important to implement a mounting system to conduct stereoscopic PIV 

in the xz plane. A rotated stereoscopic configuration is needed to capture flows with significant 

Vz components. This would enable the study of situations such as the 15º and 25º sideslip 

configurations discussed in chapter 5, where out-of-plane velocity accuracy was a hinderance to 

data collection.  
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 Fifth, replacement of the glass panel in the roof of the LSWT test section will 

significantly decrease the effort required in post-processing by removing scratches and 

imperfections that can block portions of the laser sheet during data collection. While the effects 

of these imperfections were fairly minimal, they did slightly reduce data quality in both 

stereoscopic PIV application examples as discussed in Chapter 4.  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APPENDIX A: 2-D PIV SOP 

2-D PIV Setup, Operation, and Analysis Checklist (Current as of 2/6/2020) 

Physical System Setup 
1. __ Bolt in PIV Laser Mounting Frame to top of Tunnel  

2. __ Bolt camera mounting frame to side of Tunnel  

3. __ Clamp Optics table to PIV Mounting Frame  

4. __ Bolt Laser Head to Optics Table  

5. __ Connect Laser Head to Laser Power System 

6. __ Bolt Connection Rail 1 to Optics Table  

7. __ Attach Mirror to Optics Table  

8. __ Attach Mirror, Focusing Lens and Cylindrical Lens to Connection Rail 2  

9. __ Clamp Connection Rail 2 to Connection Rail 1 

10. __ Attach Calibration Plate to desired Region of Interest 

11. __ Turn on Laser at low power (Flip Power Switch on Back > Turn Key to on > Hold Down   
 Start > press Laser 1 and Laser 2) 

12. __ Angle/move mirrors to center beam on the calibration plate 

13. __ Angle/move lenses to achieve desired beam width and thickness  

14. __ Stop Laser (Press Stop)  

15. __ Open Smoke Port inside Tunnel  

16. __ Put Smoke tubes through smoke port and attach tubes to smoke generator  

17. __ Plug Foot Pedal into Smoke Generator and Plug Smoke Generator into power  

18. __ Attach Regulator to Smoke Generator  
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19. __ Attach Compressed Air to Regulator 

20. __ Set Regulator to 30 Psi  

21. __ Attach Camera to mounting bracket  

22. __ Attach Lens to Camera 

23. __ Connect Camera to Power Box and Connect Power box to power  

24. __ Connect Camera to Computer with USB 3.0 port  

25. __ Turn On Camera  

26. __ Open PCO Camware 64  

27. __ Remove Lens Cap 

28. __ Open Exposure View windows (View > B/W Window > Image A+Image B) 

29. __ Align Camera with Calibration Plate 

 *Calibration Plate Should fill image field of view 

Data Collection 
30. __ Set Image Capture to Auto Sequence (Camera Control > Auto-Sequence > Accept) 

31. __ Record Calibration Images of Calibration Plate (Red Record button to start, white square  
to stop)  

32. __ Export Recorder Sequence (File > Export Recorder Sequence > select desired save   
  destination > Select Split doubleshutter > Save)  

33. __ Open Calibration Image and check focus and alignment (Move Camera and recapture   
 images as necessary)  

34. __ ONCE FOCUSED CALIBRATION IMAGES ARE CAPTURED: Measure Pixels Per 
Inch    on Calibration Card and write down result  
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35. __ Use Pixels per Inch and desired tunnel run speed to calculate the time for something to   
 move 20 pixels in the image 

36. __ Attach Laser to Quantum Composer (Fire Lamp 1 to T1, Fire Lamp 2 to T4,  
 Fire Q-Sw 1 to T6, Fire Q-Sw 2 to T7)  

37. __ Attach Camera to Quantum Composer (Control In Exp Trig to T8)  

38. __ Turn On Quantum Composer 

39. __ Set Laser and camera Timings (T6 delay = T1 + 190 µs, T7 Delay = T4 + 190 µs,  
 T8 delay = T0 + 0 s)  

40. __ Set time between laser pulses to the time for something to move 20 pixels with the   
  Quantum Composer (T4 delay= T1 + X seconds)  

41. __ Set time between laser pulse cycles (T1 delay = T0 + X sec)*  

 *This step Varies based on the exposure time set in PCO Camware64. This time must be  
less than the exposure time in PCO Camware 64, but greater than the exposure time    
minus T4. (AKA: PCO Exposure Time - T4 < T1 < PCO Exposure Time)  

42. __ In PCO Camware64: Set Image Capture to External Exposure start (Camera Control >   
 External Exp. Start > Accept) 

43. __ Start Laser firing (hold start > press Laser 1 and Laser 2 ) 

44. __ Turn Laser to external control (press Q-SW and Flashlamp buttons to illuminate EXT) 

45. __ Turn Laser To High Power (Toggle Low/High Button, Turn Energy Dial to display 999)  

46. __ Put on Laser Safety Goggles  

47. __ TURN ON LASER WARNING LIGHT!!! DO NOT PROCEED WITHOUT DOING 
THIS STEP!  

48. __ Turn on Smoke Generator (On Switch and on button on foot pedal)  

49. __ Once Ready light on smoke generator foot pedal is illuminated, Start the tunnel  

50. __ Generate Smoke until smoke is sufficiently dense by hitting start on pedal (no    
 measurement  for this, just use best judgement)  
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51. __ Turn all lights in the ready room, control room, and test section off  

52. __ Press Run on Quantum Composer (if laser doesn’t turn on, hit Laser 1 and Laser 2    
Buttons on Laser Power Box) 

53. __ Press Record in PCO Camware64 

54. __ Once 168 image pairs have been recorded, press stop in PCO Camware64 

55. __ Export Recorder Sequence (File > Export Recorder Sequence > select desired save   
 destination > Select Split doubleshutter > Save) 

Data Analysis 
56. __ Open DaVis 8.4.0 

57. __ Start a new PIV Project (New button in top left > type of project is PIV) 

58. __ Click Import in top Left 

59. __ Use Directory on left to navigate to the desired images and select image A of the first   
 image pair 

60. __ Define time between frames as T4 and time between images as PCO Exposure time 

61. __ Click Add to List 

62. __ Select the image from the import list in the bottom left  

63. __ Verify the file range to be imported includes the full range of images captured 

64. __ Click Import Data  

65. __ Click Exit 

66. __ Select imported dataset, then click Processing  

67. __ Add Group Vector Calculation - Double Frames, Operation PIV (particle image    
 velocimetry) 

68. __ Under Vector Calculation parameter, select Cross correlation, leave all other settings  
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69. __ Select Test Processing and verify result matches expected flow characteristics   

70. __ Repeat steps 53-55 for remainder of test 

71. __ Once All Points have been Captured, Shut Down Tunnel  

72. __ Press Stop on Quantum Composer 

73. __ To process all data, follow steps 58 - 69, but select Start processing instead of test    
processing  
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1. 

Frame should be bolted in at each corner, with 1/4-20 bolts. 

2.  

Frame is bolted into the 6 steel mounting blocks on the side of the test section. A close-up of the 
mounting bracket can be seen below:  
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3.  

The optics table should be clamped to the PIV frame on the roof of the tunnel in such a way that 
it will not vibrate or move independently from the frame. 

4. 

Laser head should be bolted into a corner position such that it minimizes the area of the 
mounting table occupied.   
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5.  

The laser head has 4 connections which must be made to ensure proper operation. The water 
routing is color coded to ensure proper flow direction.  

6. 

Connection rail 1 should be bolted onto the laser table with at least 3” of overhang to facilitate 
the attachment of Connection rail 2. Connection rail 1 can be shifted as needed to accommodate 
connection rail 2 during the installation step.  
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7.  

The first mirror should be attached directly to the optics table with a 1” tall aluminum post using 
an insert that screws directly into the holes on the optics table. Be sure to align the mirror with 
the laser such that the beam can be turned at a 90 degree angle to run parallel with connection 
rail 1.  

8. 

The mirror, focusing lens, and cylindrical lens must be spaced such that the mounts will not 
interfere with one another, and the beam will be as focused as possible going into the cylindrical 
mirror. The exact distance changes depending on the lens used, but the distance between the 
focusing lens and the cylindrical lens should be equal the focal length of the focusing lens. Be 
sure the flat side of the cylindrical lens points towards the focusing lens. Exact placement of the 
mirror can be changed to angle the laser into the focusing lens.  
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9.  

Connection rail 2 should be clamped to connection rail 1 in such a way that the mirror will angle 
the beam off the laser table and down into the focusing lens. 

10. 

The calibration plate should be set at the region of interest in the tunnel. For freestream tests and/
or measurements around a model, this requires the use of a tripod or other support structure to 
locate the calibration plate in the desired area. For model tests, the plate can be placed directly on 
the model in the region of interest. It is highly recommended to secure the plate with a strip of 
aluminum tape on the back side so that it does not fall through gaps in the floor plate and into the 
balance room.  
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11. 

When powering the laser on, it takes a few seconds after hitting start before the lasers will 
actually be able to turn on. There is a change in the frequency of the sound made by the laser 
which tells the user it is ready to be activated.   
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12.  

Coarse movements of the beam can be made by moving the mirror and its optical post within the 
mount. Fine movements can be made using the knobs on the lens holder, with the target being 
the front edge of the calibration plate. 

13. 

The focusing lens may be moved up and down connection rail 2 to change the width and 
thickness of the laser sheet. For 2-D PIV, the sheet should be made as thin as possible.  
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14. 

This step is self explanatory. To stop the laser, press the stop button on the control box.  

15. 

Remove the smoke port by unscrewing the two bolts holding the plate into the wall of the tunnel.  
 

!129



16. 

The smoke tubes are friction fit to slide together, and should not require tightening. If excess 
smoke is being released from the system during operation, slightly tighten the tubing using the 
screws located at each joiner.  

17. 

The foot pedal plugs into the back of the smoke generator, and the smoke generator power plugs 
into an extension cord that runs into the corresponding plug below the 208V AC power switch on 
the left side of the ready room.  
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18. 

The regulator can be attached to the smoke generator with a wrench. Be sure to tighten the 
connection with one wrench on the regulator input and one on the smoke generator input port to 
seal the connection as fully as possible.  
 

19. 

A compressed air line can be pulled from next to the tunnel entry door and attached to the 
regulator.  
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20. 

Depending on the regulator used, exact operation will vary, but setting the regulator to 30 psi is 
vital to the successful operation of the smoke generator. If the pressure is too low, the fog fluid 
will not be released into the heating element of the system, failing to produce any smoke. If the 
pressure is too high, the fluid will not spend enough time near the heating coil, shooting fog 
liquid into the test section of the tunnel without ever producing smoke.  

21.  

The camera should fit into the mounting bracket such that the back of the camera is flush with 
the back side of the mounting bracket, and the bottom of the camera mates flush with the inside 
surface of the mounting bracket.  
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22. 

If pulling the camera out from storage, attach the lens to the front of the camera by lining up the 
grooves on the lens and carmera base and twisting the lens until it clicks into place.  

23. 

The camera and power box are connected with a specific pinned adapter that must be screwed in 
with a flathead screwdriver. The camera power box is powered with a standard plug that is 
included in the yellow storage case.  
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24. 

Each yellow storage case also includes a USB 3.0 cord that can be used to plug the camera into 
the computer. This allows for data transfer between the camera and the computer, and is 
necessary for the images to show up in the PCO camware64 software.  

25. 

The camera is powered on by flipping the power switch on the front of the power box. Once both 
lights on the front of the box have a steady green light, proceed to the next step.  

26. 

Use the start menu or desktop shortcut to navigate to PCO camware64. This program is what we 
use to capture all PIV image pairs, and is critical for all PIV data collection.  
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27. 

Remove the lens cap on the camera to allow proper imaging of the region of interest. 

28. 

Exposure view windows can be opened by selecting the view tab, then selecting B/W window 
and clicking on image A + image B. This will produce two new windows that display the current 
view of image A and image B. 

29. 

Align the camera with the calibration plate by moving the vertical support of the mounting frame 
in the streamwise direction and moving the mounting bracket up and down on the vertical 
support. It is important to note that the calibration plate must fill the majority of the image frame 
in order for DaVis to produce a good calibration, so the zoom might need to be adjusted 
depending on the lens being used. A good camera placement can be seen below:  
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30. 

Image capture settings can be changed by selecting Camera control, then clicking auto sequence 
in the new window and accept. If done correctly, the window should look like the picture below:  

31. 

To record images, click the red record button in the top left corner of the screen. The progress bar 
in the bottom left will begin to turn blue, and the recorder sequence can be stopped at any point 
with the white square next to the record button.  
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32. 

To export the images, click file, then export recorder sequence. Use the navigation menu to select 
the desired save destination, check the split double shutter box and click save.  

33. 

Navigate to the save destination of the calibration images and open one of the images to check 
the focus and alignment of the image. It is vital that the image is well-focused, otherwise the 
particles will not be easily identified by DaVis during image processing, resulting in incorrect 
measurements. Below is an example of a well-focused and aligned calibration image. You don’t 
have to worry about any in-plane rotations of the plate, as these will be corrected during the 
calibration regime in DaVis.  
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34. 

To measure the pixels per inch, draw a volume from one side of the calibration plate to the other, 
with the corners of the box as close to the edges of the plate as possible. This will produce a pixel 
measurement for the calibration plate, which can be used to determine the conversion for pixels 
to inches. This will become relevant during setup of the quantum composer, so write the pixels 
per inch value down. 

35. 

To calculate the time for a particle to move 20 pixels in the image, one must determine a desired 
run speed in inches per second, and then use the pixels per inch value obtained in step 34 to 
convert the run speed into pixels per second. From there, calculate the time for each particle to 
move 20 pixels in the image with the following formula:  

20 ÷ (pixels per second) = Time for a particle to move 20 pixels 

36. 

Use BNC cables to attach the laser power system to the quantum composer, attaching Fire Lamp 
1 to T1, Fire Lamp 2 to T4, Fire Q-Sw 1 to T6, and Fire Q-Sw 2 to T7. It helps to have the cables 
color coded to make setup easier.  
 

!138



37. 

The camera can be attached to the quantum composer with another BNC cable, running camera 
external exp trig to T8.  

38. 

Turning on the quantum composer is as simple as hitting the power button on the quantum 
composer. If it doesn’t turn on, ensure that it is plugged in.  
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39 - 41. 

To set the laser and camera timings, use the next button to navigate to the time delay for a given 
channel, and use the arrow keys on the quantum composer to change the time delay and 
reference time for that channel. For the reference time, T0 refers to the moment the run button is 
pressed, while all other TX values set the reference to another channel. To shift between channels 
(T1 to T2, etc.), press function and then channel. 

42. 

To set the camera control to external control in PCO camware64, select camera control, then 
click external exposure start and then accept.  

!140



 
43. 

To start the laser firing, press and hold start on the laser for approximately 2 seconds. Once the 
whirring of the laser decreases in frequency (clear audio cue), then press the laser 1 and laser 2 
buttons to start the laser firing.  

44. 

Switch the laser to external control by pressing the Flashlamp and Q-SW buttons so that the light 
under EXT is illuminated.  
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45. 

Turn the laser to high power by pressing the pressing the low/high button so that the light under 
high is illuminated, and turn the energy dial clockwise until the digital readout displays 999.  

46. 

Before proceeding, it is imperative that all personnel that will be in the ready room while 
conducting PIV are wearing laser safety goggles. The LSWT has multiple pairs that can be worn, 
including two that can be worn over normal glasses. At high power, this laser can do permanent 
damage to the naked eye, so it is vital that you are wearing proper safety attire prior to use of the 
laser at high power.  

47. 

It is also vital that you turn on the laser warning light. The switch may be found on the shelf in 
the front right corner of the control room on the shelf. This will illuminate the red lights above 
each entry to the ready room so that everyone in the facility will know the laser is in use and will 
take the necessary safety precautions.  
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48. 

Turn on the smoke generator by flipping the switch on the generator and then pressing the on 
button on the foot pedal.  

49. 

This step is fairly self explanatory, there is a light on the foot pedal of the smoke generator that is 
labeled ready. When the generator is sufficiently warm, the ready light will turn green. When this 
happens, start the tunnel and get up to the desired speed.  

50. 

To generate smoke sufficiently dense for PIV measurements, press the start button on the foot 
pedal and allow the system to generate smoke until you see smoke coming from the settling 
chamber and into the test section. When that occurs, press the start button again and move to the 
next step.  

51. 

This step is also self explanatory. Turn off all lights in the ready room, control room, and test 
section. The goal is to eliminate as much light as possible to maximize the contrast between the 
particles illuminated by the laser sheet and the background of the image. Thus, making the room 
as dark as possible is ideal.  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52. 

Press the run button on the quantum composer to start the laser. Sometimes the laser will not start 
up on the first press of Run for reasons unknown. If this happens, leave the quantum composer 
running and press the laser 1 and laser 2 buttons on the laser power box.  

53. 

To record image pairs, click the red record button in the top left corner of PCO camware64. 
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54.  

Once the blue progress bar in the lower left portion of the screen is full, press stop in the upper 
left corner of PCO camware 64.  

55. 

To export the images, click file, then export recorder sequence. Use the navigation menu to select 
the desired save destination, check the split double shutter box and click save.  
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56. 

Now that a dataset has been captured, it must be analyzed to ensure the image pairs captured 
produce reasonable data. To do this, DaVis 8.4.0 must be opened. It is important to note that the 
license dongle must be inserted into one of the USB ports on the computer in order for the 
program to open.  

57. 

To start a new PIV project, select the new icon in the top left corner of the screen. Select specify 
and input the desired project name, and be sure to designate the type of project as PIV before 
hitting ok.  
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58. 

To import the desired image pairs, select the import icon in the top left corner of the screen. This 
should send you to the screen shown below:  

59. 

Use the directory to navigate to the desired set of images for importing, and select image A from 
the first image pair of the dataset.  
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60. 

In the import menu, define the time between frames as the delay on T4 in the quantum composer 
and the time between images as the exposure time defined in PCO camware64.  

61. 

Click the add to list button on the left side of the screen to prepare the images for importing.  
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62. 

Now that Add to list has been clicked, the desired image should appear in the import list on the 
lower left corner of the screen. To view the import details for the desired dataset, select the image 
from the import list.  

63. 

Verifying the full range of images is imported by verifying the full range box is checked under 
the import details for the desired dataset. This range is located on the bottom left side of the 
screen, next to the import list.  
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64. 

The import data button can also be found on the lower left side of the screen, beneath the import 
details and import list prompts. Clicking this button will import all image pairs from the import 
list into DaVis for processing. 

65. 

Once the exit icon in the top left corner becomes selectable, click exit to return to the project 
home screen.  
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66. 

To process data, select the newly imported data and click processing in the top toolbar. This will 
navigate you to the data processing screen.  

67. 

To add a new processing step, clear the operation list with the red x in the upper right corner of 
the list, and then add a new operation. Under group, select Vector Calculation - Double Frames, 
and under operation select PIV (particle image velocimetry). Storage mode and storage name 
should be left alone.   
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68. 

Select Vector calculation parameter in the operation list, and then click cross correlation. All 
other settings should be left in their defaults. You can verify that the settings match the image 
shown below:   

69. 

Select test processing and allow DaVis to process the first image pair. The results will show up in 
the results box on the lower right side of the screen. Once this is complete, verify the flow 
directions and values are reasonable by using the relevant vector filters under the vector length 
option in the upper toolbar. The test processing button can be seen in the lower portion of the 
image below, and the vector length selection can be seen greyed out in the top center of the 
image below.  
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70. 

Repeat steps 53- 55 as many times as necessary to capture all requested data for the test. 
Depending on the customer, you may want to capture multiple datasets at each point, this is 
something that is by no means required, and only affects the amount of data that is taken.  

71. 

Once all data has been captured for a given run, shut down the tunnel. 

72. 

Press stop on the quantum composer to stop the laser pulses in the tunnel. This is imperative 
before removing safety glasses or turning off the laser warning light.  

73. 

To process all data for a specified point, follow steps 58 - 69, but select Start processing instead 
of test processing to batch process all the image pairs for that run.   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APPENDIX B: STEREO-PIV SOP 

Stereo PIV Setup, Operation, and Analysis Checklist (Current as of 2/6/2020) 

Physical System Setup 
1. __ Bolt in PIV Laser Mounting Frame to top of Tunnel  

2. __ Bolt camera mounting frame to side of Tunnel  

3. __ Clamp Optics table to PIV Mounting Frame  

4. __ Bolt Laser Head to Optics Table  

5. __ Connect Laser Head to Laser Power System 

6. __ Bolt Connection Rail 1 to Optics Table  

7. __ Attach Mirror to Optics Table 

8. __ Attach mirror, Focusing Lens and Cylindrical Lens to Connection Rail 2  

9. __ Clamp Connection Rail 2 to Connection Rail 1 

10. __ Attach Calibration Plate to Desired area of Interest  

11. __ Turn on Laser at low power (Flip Power Switch on Back > Turn Key to on > Hold Down   
 Start > press Laser 1 and Laser 2) 

12. __ Angle/move mirrors to center beam on calibration plate 

13. __ Angle/move lenses to achieve desired beam width and thickness  

14. __ Stop Laser (Press Stop)  

15. __ Open Smoke Port inside Tunnel  

16. __ Put Smoke tubes through smoke port and attach tubes to smoke generator  

17. __ Plug Foot Pedal into Smoke Generator and Plug Smoke Generator into power  

18. __ Attach Regulator to Smoke Generator  
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19. __ Attach Compressed Air to Regulator 

20. __ Set Regulator to 30 Psi  

21. __ Attach Cameras to mounting bracket 

22. __ Attach Lenses to Cameras 

23. __ Connect Cameras to Power Boxes and Connect Power boxes to power  

24. __ Connect Cameras to Computer with USB 3.0 port  

25. __ Turn On Cameras 

26. __ Open PCO Camware 64  

27. __ Remove Lens Caps 

28. __ Open Exposure View windows for camera 1 (View > B/W Window > Camera 1 >Image   
 A+Image B) 

29. __ Open Exposure View windows for camera 2 (View > B/W Window > Camera 2 >Image   
 A+Image B) 

30. __ Align Cameras with Stereo-PIV Calibration Plate 

Data Collection  
31. __ Set Image Capture to Auto Sequence (Camera Control > Camera 1/2 > Auto-Sequence   
 > Accept > right-click image and select auto range crop) 

32. __ Record Calibration Images (Red Record button to start, white square to stop)  

 * Note that Calibration Plate should fill the Image Field of View 

33. __ Export Camera 1 Recorder Sequence (File > Export Recorder Sequence > select desired  
save destination > Select Split doubleshutter > Save > Select Yes) 

34. __ Export Camera 2 Recorder Sequence (File > Export Recorder Sequence > select desired  
save destination > Select Split doubleshutter > Save > Select Yes) 

35. __ Write down/Remember which camera is Left Camera and which camera is Right Camera 
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36. __ Open Calibration Images and check focus and alignment (Move Cameras and recapture   
images as necessary)  

37. __ ONCE FOCUSED CALIBRATION IMAGES ARE CAPTURED: Measure Pixels Per  
 Inch on Calibration Card and write down result (pixels appear as an AAA x BBB at the   
 top of the image) 

38. __ Use Pixels per Inch and desired tunnel run speed to calculate the time for something to   
 move 20 pixels in the image 

39. __ Attach Laser to Quantum Composer (Fire Lamp 1 to T1, Fire Lamp 2 to T4,  
 Fire Q-Sw 1 to T6, Fire Q-Sw 2 to T7)  

40. __ Attach Cameras to Quantum Composer (Control In Exp Trig on both cameras to T8)  

41. __ Turn On Quantum Composer 

42. __ Set Laser and camera Timings (T6 delay = T1 + 190 µs, T7 Delay = T4 + 190 µs,  
 T8 delay = T0 + 0 s)  

43. __ Set time between laser pulses to the time for something to move 20 pixels with the   
 Quantum Composer (T4 delay= T1 + X seconds)  

44. __ Set time between laser pulse cycles (T1 delay = T0 + X sec)*  

 *This step Varies based on the exposure time set in PCO Camware64. This time must be  
less than the exposure time in PCO Camware 64, but greater than the exposure time    
minus T4. (AKA: PCO Exposure Time - T4 < T1 < PCO Exposure Time) 

45. __ In PCO Camware64: Set Image Capture to External Exposure start (Camera Control >   
 External Exp. Start > Accept) 

46. __ Start Laser firing (hold start > press Laser 1 and Laser 2 ) 

47. __ Turn Laser to external control (press Q-SW and Flashlamp buttons to illuminate EXT) 

48. __ Turn Laser To High Power (Toggle Low/High Button, Turn Energy Dial to display 999)  

49. __ Put on Laser Safety Goggles  

50. __ TURN ON LASER WARNING LIGHT!!! DO NOT PROCEED WITHOUT DOING  
THIS STEP!   

!156



51. __ Turn on Smoke Generator (On Switch and on button on foot pedal)  

52. __ Once Ready light on smoke generator foot pedal is illuminated, Start the tunnel  

53. __ Generate Smoke until smoke is sufficiently dense by hitting start on pedal (no    
 measurement  for this, just use best judgement)  

54. __ Turn all lights in the ready room, control room, and test section off  

55. __ Press Run on Quantum Composer (if laser doesn’t turn on, hit Laser 1 and Laser 2    
Buttons on Laser Power Box) 

56. __ Press Record in PCO Camware64 

57. __ Once 168 image pairs have been recorded by each camera, press stop in PCO    
 Camware64 

58. __ Export Camera 1 Recorder Sequence (File > Export Recorder Sequence > select desired  
save destination > Select Split doubleshutter > Save) 

59. __ Export Camera 2 Recorder Sequence (File > Export Recorder Sequence > select desired  
save destination > Select Split doubleshutter > Save) 

Data Analysis 
60. __ Open DaVis 8.4.0 

61. __ Start a new PIV Project (New button in top left > type of project is PIV) 

62. __ Click Import in top Left 

63. __ Use Directory on left to navigate to the Left Camera images and select image A of the   
 first image pair 

64. __ Define time between frames as T4 and time between images as 20,000 µs 

65. __ Click Add to List 

66. __ Select the image from the import list in the bottom left  

67. __ Verify the file range to be imported is 1 - 168 
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68. __ Click Import Data  

69. __ Click Exit  

70. __ Click Import in top Left 

71. __ Use Directory on left to navigate to the Right Camera images and select image A of the   
 first image pair 

72. __ Define time between frames as T4 and time between images as PCO Exposure Time 

73. __ Click Add to List 

74. __ Select the image from the import list in the bottom left  

75. __ Verify the file range to be imported is 1 - 168 

76. __ Click Import Data  

77. __ Click Exit 

78. __ Select Left Camera data set, then click processing  

79. __ Add Group copy and reorganize data sets, operation merge data sets to multi frame 

80. __ Click Parameters, then use search on the right to select the corresponding right camera   
dataset 

81. __ Start Processing  

82. __ Click Exit when processing is finished  

83. __ Select the new MergeDatasets and click Processing 

84. __ Add Group attributes, Operation add Default Attributes  

85. __ Click Parameters, and change number of cameras to 2, set 2. Camera to camera 2, and   
select overwrite existing attributes 

86. __ Start Processing  

87. __ Click Exit when processing is finished  
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88. __ Select the new AddDefaultAttributes and click Processing  

89. __ Add Group vector calculation - double frames, Operation PIV (particle image    
 velocimetry) 

90. __ Click Vector calculation parameter, and select Stereo Cross Correlation without    
 changing other settings  

91. __ Click Test Processing verify result matches expected flow characteristics   

92. __ Repeat steps 56-59 for remainder of test 

93. __ Once All Points have been Captured, Shut Down Tunnel  

94. __ Press Stop on Quantum Composer  

95. __ To Process all data follow steps 62-91, but select Start processing on step 91 instead of 
test processing  
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1. 

Frame should be bolted in at each corner, with 1/4-20 bolts. 

2.  

Frame is bolted into the 6 steel mounting blocks on the side of the test section. A close-up of the 
mounting bracket can be seen below:  
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3.  

The optics table should be clamped to the PIV frame on the roof of the tunnel in such a way that 
it will not vibrate or move independently from the frame. 

4. 

Laser head should be bolted into a corner position such that it minimizes the area of the 
mounting table occupied.   
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5.  

The laser head has 4 connections which must be made to ensure proper operation. The water 
routing is color coded to ensure proper flow direction.  

6. 

Connection rail 1 should be bolted onto the laser table with at least 3” of overhang to facilitate 
the attachment of Connection rail 2. Connection rail 1 can be shifted as needed to accommodate 
connection rail 2 during the installation step.  
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7.  

The first mirror should be attached directly to the optics table with a 1” tall aluminum post using 
an insert that screws directly into the holes on the optics table. Be sure to align the mirror with 
the laser such that the beam can be turned at a 90 degree angle to run parallel with connection 
rail 1.  

8. 

The mirror, focusing lens, and cylindrical lens must be spaced such that the mounts will not 
interfere with one another, and the beam will be as focused as possible going into the cylindrical 
mirror. The exact distance changes depending on the lens used, but the distance between the 
focusing lens and the cylindrical lens should be equal the focal length of the focusing lens. Be 
sure the flat side of the cylindrical lens points towards the focusing lens. Exact placement of the 
mirror can be changed to angle the laser into the focusing lens.  
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9.  

Connection rail 2 should be clamped to connection rail 1 in such a way that the mirror will angle 
the beam off the laser table and down into the focusing lens. 

10. 

The calibration plate should be set at the region of interest in the tunnel. For freestream tests and/
or measurements around a model, this requires the use of a tripod or other support structure to 
locate the calibration plate in the desired area. For model tests, the plate can be placed directly on 
the model in the region of interest. It is highly recommended to secure the plate with a strip of 
aluminum tape on the back side so that it does not fall through gaps in the floor plate and into the 
balance room.  
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11. 

When powering the laser on, it takes a few seconds after hitting start before the lasers will 
actually be able to turn on. There is a change in the frequency of the sound made by the laser 
which tells the user it is ready to be activated.   
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12.  

Coarse movements of the beam can be made by moving the mirror and its optical post within the 
mount. Fine movements can be made using the knobs on the lens holder, with the target being 
the front edge of the calibration plate. 

13. 

The focusing lens may be moved up and down connection rail 2 to change the width and 
thickness of the laser sheet. For 2-D PIV, the sheet should be made as thin as possible.  
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14. 

This step is self explanatory. To stop the laser, press the stop button on the control box.  

15. 

Remove the smoke port by unscrewing the two bolts holding the plate into the wall of the tunnel.  
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16. 

The smoke tubes are friction fit to slide together, and should not require tightening. If excess 
smoke is being released from the system during operation, slightly tighten the tubing using the 
screws located at each joiner.  

17. 

The foot pedal plugs into the back of the smoke generator, and the smoke generator power plugs 
into an extension cord that runs into the corresponding plug below the 208V AC power switch on 
the left side of the ready room.  
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18. 

The regulator can be attached to the smoke generator with a wrench. Be sure to tighten the 
connection with one wrench on the regulator input and one on the smoke generator input port to 
seal the connection as fully as possible.  
 

 

19. 

A compressed air line can be pulled from next to the tunnel entry door and attached to the 
regulator.  
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20. 

Depending on the regulator used, exact operation will vary, but setting the regulator to 30 psi is 
vital to the successful operation of the smoke generator. If the pressure is too low, the fog fluid 
will not be released into the heating element of the system, failing to produce any smoke. If the 
pressure is too high, the fluid will not spend enough time near the heating coil, shooting fog 
liquid into the test section of the tunnel without ever producing smoke.  

21.  

Each camera should fit into the mounting bracket such that the back of the camera is flush with 
the back side of the mounting bracket, and the bottom of the camera mates flush with the inside 
surface of the mounting bracket.  
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22. 

If pulling the cameras out from storage, attach the lens to the front of each camera by lining up 
the grooves on the lens and camera base and twisting the lens until it clicks into place.  

23. 

The camera and power box are connected with a specific pinned adapter that must be screwed in 
with a flathead screwdriver. The camera power box is powered with a standard plug that is 
included in the yellow storage case.  
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24. 

Each yellow storage case also includes a USB 3.0 cord that can be used to plug the cameras into 
the computer. This allows for data transfer between the cameras and the computer, and is 
necessary for the images to show up in the PCO camware64 software.  

25. 

Each camera is powered on by flipping the power switch on the front of the power box. Once 
both lights on the front of the box have a steady green light, proceed to the next step.  

26. 

Use the start menu or desktop shortcut to navigate to PCO camware64. This program is what we 
use to capture all PIV image pairs, and is critical for all PIV data collection.  
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27. 

Remove the lens cap on the camera to allow proper imaging of the region of interest. 

28. 

Exposure view windows can be opened by selecting the view tab, then selecting B/W window 
and clicking on image A + image B. Then select camera 1 to open the viewing windows for 
image A and image B of camera 1. 

29. 

Exposure view windows can be opened by selecting the view tab, then selecting B/W window 
and clicking on image A + image B. Then select camera 2 to open the viewing windows for 
image A and image B of camera 2. 
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30. 

Align the camera with the calibration plate by moving the vertical support of the mounting frame 
in the streamwise direction and moving the mounting bracket up and down on the vertical 
support. It is important to note that the calibration plate must fill the majority of the image frame 
in order for DaVis to produce a good calibration, so the zoom might need to be adjusted 
depending on the lens being used. A good camera placement can be seen below:  

31. 

Image capture settings can be changed by selecting Camera control, then clicking auto sequence 
in the new window and accept. If done correctly, the window should look like the picture below:  
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32. 

To record images, click the red record button in the top left corner of the screen. The progress bar 
in the bottom left will begin to turn green, and the recorder sequence can be stopped at any point 
with the white square next to the record button.  

33. 

To export the images, click one of the frames corresponding to the left camera, then file, then 
export recorder sequence. Use the navigation menu to select the desired save destination, check 
the split double shutter box and click save.  
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34. 

To export the images, click one of the frames corresponding to the right camera, then file, then 
export recorder sequence. Use the navigation menu to select the desired save destination, check 
the split double shutter box and click save.  

35. 

In PCO camware64, the cameras used are displayed as camera 1 and camera 2. In DaVis, it is 
very helpful to have things labeled as left and right camera to make data importing and 
processing simpler. Thus, it is very helpful to know which camera number corresponds to left 
and right camera respectively.  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36. 

Navigate to the save destination of the calibration images and open one of the images to check 
the focus and alignment of the image. It is vital that the image is well-focused, otherwise the 
particles will not be easily identified by DaVis during image processing, resulting in incorrect 
measurements. Below is an example of a well-focused and aligned calibration image. You don’t 
have to worry about any in-plane rotations of the plate, as these will be corrected during the 
calibration regime in DaVis.  

37. 

To measure the pixels per inch, draw a volume from one side of the calibration plate to the other, 
with the corners of the box as close to the edges of the plate as possible. This will produce a pixel 
measurement for the calibration plate, which can be used to determine the conversion for pixels 
to inches. This will become relevant during setup of the quantum composer, so write the pixels 
per inch value down. 

38. 

To calculate the time for a particle to move 20 pixels in the image, one must determine a desired 
run speed in inches per second, and then use the pixels per inch value obtained in step 34 to 
convert the run speed into pixels per second. From there, calculate the time for each particle to 
move 20 pixels in the image with the following formula:  

20 ÷ (pixels per second) = Time for a particle to move 20 pixels 
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39. 

Use BNC cables to attach the laser power system to the quantum composer, attaching Fire Lamp 
1 to T1, Fire Lamp 2 to T4, Fire Q-Sw 1 to T6, and Fire Q-Sw 2 to T7. It helps to have the cables 
color coded to make setup easier.  

40. 

The camera can be attached to the quantum composer with another BNC cable, running camera 
external exp trig to T8.  
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41. 

Turning on the quantum composer is as simple as hitting the power button on the quantum 
composer. If it doesn’t turn on, ensure that it is plugged in.  

42 - 44. 

To set the laser and camera timings, use the next button to navigate to the time delay for a given 
channel, and use the arrow keys on the quantum composer to change the time delay and 
reference time for that channel. For the reference time, T0 refers to the moment the run button is 
pressed, while all other TX values set the reference to another channel. To shift between channels 
(T1 to T2, etc.), press function and then channel. 
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45. 

To set the camera control to external control in PCO camware64, select camera control, then 
click external exposure start and then accept.  
 

46. 

To start the laser firing, press and hold start on the laser for approximately 2 seconds. Once the 
whirring of the laser decreases in frequency (clear audio cue), then press the laser 1 and laser 2 
buttons to start the laser firing.  
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47. 

Switch the laser to external control by pressing the Flashlamp and Q-SW buttons so that the light 
under EXT is illuminated.  

48. 

Turn the laser to high power by pressing the pressing the low/high button so that the light under 
high is illuminated, and turn the energy dial clockwise until the digital readout displays 999.  
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49. 

Before proceeding, it is imperative that all personnel that will be in the ready room while 
conducting PIV are wearing laser safety goggles. The LSWT has multiple pairs that can be worn, 
including two that can be worn over normal glasses. At high power, this laser can do permanent 
damage to the naked eye, so it is vital that you are wearing proper safety attire prior to use of the 
laser at high power.  

50. 

It is also vital that you turn on the laser warning light. The switch may be found on the shelf in 
the front right corner of the control room on the shelf. This will illuminate the red lights above 
each entry to the ready room so that everyone in the facility will know the laser is in use and will 
take the necessary safety precautions.  

51. 

Turn on the smoke generator by flipping the switch on the generator and then pressing the on 
button on the foot pedal.  

52. 

This step is fairly self explanatory, there is a light on the foot pedal of the smoke generator that is 
labeled ready. When the generator is sufficiently warm, the ready light will turn green. When this 
happens, start the tunnel and get up to the desired speed.  
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53. 

To generate smoke sufficiently dense for PIV measurements, press the start button on the foot 
pedal and allow the system to generate smoke until you see smoke coming from the settling 
chamber and into the test section. When that occurs, press the start button again and move to the 
next step.  

54. 

This step is also self explanatory. Turn off all lights in the ready room, control room, and test 
section. The goal is to eliminate as much light as possible to maximize the contrast between the 
particles illuminated by the laser sheet and the background of the image. Thus, making the room 
as dark as possible is ideal.  

55. 

Press the run button on the quantum composer to start the laser. Sometimes the laser will not start 
up on the first press of Run for reasons unknown. If this happens, leave the quantum composer 
running and press the laser 1 and laser 2 buttons on the laser power box.  
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56. 

To record image pairs, click the red record button in the top left corner of PCO camware64. 

57.  

Once the blue progress bar in the lower left portion of the screen is full, press stop in the upper 
left corner of PCO camware 64.  
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58. 

To export the images click one of the frames corresponding to camera 1, then file, then export 
recorder sequence. Use the navigation menu to select the desired save destination, check the split 
double shutter box and click save.  

59. 

To export the images click one of the frames corresponding to camera 2, then file, then export 
recorder sequence. Use the navigation menu to select the desired save destination, check the split 
double shutter box and click save.  
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60. 

Now that a dataset has been captured, it must be analyzed to ensure the image pairs captured 
produce reasonable data. To do this, DaVis 8.4.0 must be opened. It is important to note that the 
license dongle must be inserted into one of the USB ports on the computer in order for the 
program to open.  

61. 

To start a new PIV project, select the new icon in the top left corner of the screen. Select specify 
and input the desired project name, and be sure to designate the type of project as PIV before 
hitting ok.  
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62. 

To import the desired image pairs, select the import icon in the top left corner of the screen. This 
should send you to the screen shown below:  

63. 

Use the directory to navigate to the desired set of images for importing, and select image A from 
the first image pair of the dataset.  
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64. 

In the import menu, define the time between frames as the delay on T4 in the quantum composer 
and the time between images as the exposure time defined in PCO camware64.  

65. 

Click the add to list button on the left side of the screen to prepare the images for importing.  

!188



66. 

Now that Add to list has been clicked, the desired image should appear in the import list on the 
lower left corner of the screen. To view the import details for the desired dataset, select the image 
from the import list.  

67. 

Verifying the full range of images is imported by verifying the range listed under the import 
details for the desired dataset is 1-168. This range is located on the bottom left side of the screen, 
next to the import list.  
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68. 

The import data button can also be found on the lower left side of the screen, beneath the import 
details and import list prompts. Clicking this button will import all image pairs from the import 
list into DaVis for processing. 

69. 

Once the exit icon in the top left corner becomes selectable, click exit to return to the project 
home screen.  
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70. 

To import the desired image pairs, select the import icon in the top left corner of the screen. This 
should send you to the screen shown below:  

71. 

Use the directory to navigate to the desired set of images for importing, and select image A from 
the first image pair of the dataset.  
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72. 

In the import menu, define the time between frames as the delay on T4 in the quantum composer 
and the time between images as the exposure time defined in PCO camware64.  

73. 

Click the add to list button on the left side of the screen to prepare the images for importing.  
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74. 

Now that Add to list has been clicked, the desired image should appear in the import list on the 
lower left corner of the screen. To view the import details for the desired dataset, select the image 
from the import list.  

75. 

Verifying the full range of images is imported by verifying the range listed under the import 
details for the desired dataset is 1-168. This range is located on the bottom left side of the screen, 
next to the import list.  
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76. 

The import data button can also be found on the lower left side of the screen, beneath the import 
details and import list prompts. Clicking this button will import all image pairs from the import 
list into DaVis for processing. 

77. 

Once the exit icon in the top left corner becomes selectable, click exit to return to the project 
home screen.  
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78. 

To process data, select the newly imported left camera data and click processing in the top 
toolbar. This will navigate you to the data processing screen.  

79. 

To add a new processing step, clear the operation list with the red x in the upper right corner of 
the list, and then add a new operation. Under group, select copy and reorganize data sets, and 
under operation select merge data sets to multi frame. Storage mode and storage name should be 
left alone.   
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80. 

Clicking the parameters option in the operation list brings up the ability to select data sets. Using 
the open folder icon, you can navigate to the imported right camera data and select it. If done 
properly, it should look like the following image:  

81. 

Select start processing and allow DaVis to complete its processing.   
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82. 

Once the exit icon in the top left corner becomes selectable, click exit to return to the project 
home screen.  

83. 

To process data, select the plus next to the left camera data set, select the newly produced merge 
datasets and click processing in the top toolbar. This will navigate you to the data processing 
screen for the merged data.  
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84. 

To add a new processing step, clear the operation list with the red x in the upper right corner of 
the list, and then add a new operation. Under group, select attributes, and under operation select 
add default attributes. Storage mode and storage name should be left alone.   

85. 

Clicking the parameters option in the operation list brings up the ability to change data settings. 
Change the number of cameras to 2, change the 2. camera: to camera 2, and check the overwrite 
existing attributes box. If done properly, it should look like the following image:  
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86. 

Select start processing and allow DaVis to complete its processing.   

87. 

Once the exit icon in the top left corner becomes selectable, click exit to return to the project 
home screen.  
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88. 

To process data, select the plus next to the left camera data set, and the plus next to 
MergeDatasets, and select the newly produced AddDefaultAttributes. Next, click processing in 
the top toolbar. This will navigate you to the data processing screen for the merged data.  

89. 

To add a new processing step, clear the operation list with the red x in the upper right corner of 
the list, and then add a new operation. Under group, select Vector Calculation - Double Frames, 
and under operation select PIV (particle image velocimetry). Storage mode and storage name 
should be left alone.   
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90. 

Select Vector calculation parameter in the operation list, and then click cross correlation. All 
other settings should be left in their defaults. You can verify that the settings match the image 
shown below:   

91. 

Select test processing and allow DaVis to process the first image pair. The results will show up in 
the results box on the lower right side of the screen. Once this is complete, verify the flow 
directions and values are reasonable by using the relevant vector filters under the vector length 
option in the upper toolbar. The test processing button can be seen in the lower portion of the 
image below, and the vector length selection can be seen greyed out in the top center of the 
image below.  

!201



92. 

Repeat steps 56-59 as many times as necessary to capture all requested data for the test. 
Depending on the customer, you may want to capture multiple datasets at each point, this is 
something that is by no means required, and only affects the amount of data that is taken.  

93. 

Once all data has been captured for a given run, shut down the tunnel. 

94. 

Press stop on the quantum composer to stop the laser pulses in the tunnel. This is imperative 
before removing safety glasses or turning off the laser warning light.  

95. 

To process all data for a specified point, follow steps 62-91, but select Start processing instead of 
test processing to batch process all the image pairs for that run.
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